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Welcome to Universal Type Server
Universal Type Server® is the next generation of workgroup font management software. Written for the
latest operating systems, this cross-platform system combines the power, speed, and control that
administrators need with the seamless font delivery and elegant interface that users expect.

Type Server® provides centralized control, consistency, and compliance for all levels of font management—
administrators as well as client users. Administrators can rest assured that the appropriate fonts are available
to the client when they need them, and rogue fonts are kept out of the workflow. Meanwhile, users are
certain that they are using the correct, approved fonts for their projects by using the Universal Type Client™.

If you have just installed Universal Type Server and want to get going quickly, you should do these things:

Log in to the Server Administration application.
1. Open a new browser tab or window.
2. Enter the address of your Type Server, followed by the port number for the Server Administration

application. By default, this port is 18081.
Example: http://127.0.0.1:18081

3. Log in using the account name administrator and password password.

Enter your license numbers.
1. Click Licenses in the list on the left.
2. Enter your serial number and click Add Serial Number.
3. If you have a Core Client license, enter that serial number and click Add Serial Number.

For further configuration steps, see Installation Overview on page 10.

After you configure your server, you should change the administrator account password. Do this in the User
Management application.

1. Open a new browser window or tab.
2. Enter the address of your Type Server, followed by the port number for the User Management

application. By default, this port is 8080.
Example: http://127.0.0.1:8080

3. Log in using the administrator account credentials listed above.
4. In the Workgroups pane, clickAll Users.
5. In the Users pane, select the Administrator user account.
6. In the Details pane, click the Account tab and enter a new password in the Password field, then

enter it again in the Confirm Password field.
Write your new password down; if you forget it, you will need to contact Extensis Technical Support
for assistance in resetting the password.

7. Click Save.

For details about using the User Management application, see the Help system in the application.

About the Server Administration Guide
This Server Administration guide provides instructions for installing and configuring the server, as well as
general server management information.

Universal Type Server is administered through three primary applications: the Server Administration
application, the User Management application, and the Universal Type Client. In addition, Enterprise
installations have access to the Universal Type Core Client for users that do not have changing font needs.
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For detailed instructions about configuring roles, workgroups and users, please see the User Management
Guide, or the help system available within the application.

All management of the physical font files such as adding fonts to the server is accomplished in the Universal
Type Client. Other administrative functions such as running license reports are also performed from the Type
Client. For information about these features as well as all other client operations, please see the Universal
Type Client User Guide or choose Help > Universal Type Client Help.

What’s New
New in 6.1.7
n Font Connector for Esko ArtPro+
n QuarkXPress 2018 auto-activation plug-in

New in 6.1
Universal Type Server
n Update to use Java 8 and JBoss 10 to ensure the highest level of security
n Secure server transmissions now utilize TLS v1.

Universal Type Client
n Added auto-activation plug-in and Extensis Font Panel support for Adobe InDesign, Illustrator, and

Photoshop CC 2015 (Summer 2016).
n Added auto-activation plug-in support for Adobe InCopy and After Effects CC 2015 (Summer 2016)

and QuarkXPress 2016.

User Management
n New report: Font Usage

New in 6.0
Universal Type Server
n New report analytics engine that will help server administrators know everything about their font

environment at their fingertips
n Configurable server memory management
n Support for OS X El Capitan

Universal Type Client
n Auto-activation plug-in for Adobe After Effects

User Management
n Enhanced, extensible reporting module
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Recent updates
Universal Type Server
n FontLink for Adobe® InDesign® Server allows InDesign Server to connect to your Universal Type Server

to include managed fonts in your automated workflow.
n TurboSync™: Fonts and metadata replicate to clients up to 27 times faster.
n Failover configuration: Enterprise users can set up a second Universal Type Server to ensure maximum

up-time with minimum disruption.
n External SQL database: Enterprise users can add a high-performance database for user and workgroup

maintenance and font usage tracking.
n Fully 64-bit native for improved performance and better system resource utilization.

Universal Type Client
n Extensis Font Panel: The Extensis Font Panel allows you to access all of your workgroups directly in

Adobe InDesign, Illustrator, and Photoshop CS6 and later.
n “My Fonts” Workgroup: Users can now see the fonts in all their workgroups in one place.
n Font Favorites: Mark fonts as favorites and easily find them when you need them. Use them to search

fonts and create smart sets.
n Fontspiration: The Details Panel includes the new Fontspiration tab. Fontspiration displays examples of

WebINK fonts designed to inspire you to seek new and unique ways to use typography in your own
projects. Click an example to view that example in your Web browser, and from there follow
Fontspiration and view the thousands of typography examples gleaned from around the Web.

n QuarkXPress 10: Universal Type Client includes an auto-activation plug-in for QuarkXPress 10 and
10.1, and can also clean font caches for the Macintosh version.

n QuickComp: QuickComp is a new Preview option that displays your font choices used in a variety of
document layouts. Multiple templates are available that mimic brochures, newsletters, and other
common design projects.

n Details Panel: The Details Panel has been enlarged and moved from the bottom left to the right side of
the main window. It displays more details about anything you select in the Workgroups pane, provides
shortcuts for QuickFind searches using many popular search criteria, and allows you to directly edit some
properties.

n Color Previews: You can now set the font and background colors used in the Previews pane. Test color
combinations, use them in floating previews, and grab a Font Snapshot.

n Support for Adobe Creative Cloud apps and Typekit fonts.

User Management
n Full Administrator users can now access the User Management application using their standard LDAP

credentials.
n Compliance model: Universal Type Server uses a “per-machine” licensing model, similar to licenses

purchased from most type foundries.
n Enfocement options: Enterprise users can choose between strict enforcement, in which fonts are not

allowed to be activated beyond the limits of your licenses, or notification, in which you receive an alert
whenever a font is used beyond the number of available licenses.

n Map Active Directory groups directly to Type Server workgroups.
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System Requirements
For the most up-to-date information about the latest release of Universal Type Server, please visit the
Product Support page (https://www.extensis.com/support/universal-type-server-6/).

Macintosh Server
n OS X® 10.8 through 10.13
n 2.0 GHz or faster processor
n 2 GB RAM
n 2 GB available hard drive space for application files, plus additional space for fonts

Windows Server
n Windows® Server 2008 R2, Windows Server 2012, Windows Server 2012 R2, or Windows

Server 2016
n 2.0 GHz or faster multi-core processor
n 2 GB RAM
n 2 GB available hard drive space for application files, plus additional space for fonts

Enterprise Edition Database Requirements
Enterprise Edition users have the option of utilizing one of these external databases. Use of an external
database is required with a proxy failover configuration.
n MySQL 5.5 or newer (Macintosh or Windows)
n Microsoft SQL Server 2012 or 2014 (Windows)

Macintosh Universal Type Client
n OS X® 10.8 through 10.13
n 2.0 GHz or faster processor
n 1 GB available hard drive space for application files, plus additional space for fonts
n 100 Mbit/s or faster network connection
n An Internet connection and Safari® 7 or later or the current release of Firefox® or Chrome™ to view

Help

Windows Universal Type Client
n Windows® 7, Windows 8, Windows 8.1, or Windows 10
n 2.0 GHz or faster processor
n 1 GB available hard drive space for application files, plus additional space for fonts
n 100 Mbit/s or faster network connection
n An Internet connection and Internet Explorer® 10, Microsoft Edge, or the current release of Firefox or

Chrome to view Help

You need to have Internet Explorer installed in order for QuickComp to work properly. It does not need to be
your default browser.

https://www.extensis.com/support/universal-type-server-6/
https://www.extensis.com/support/universal-type-server-6/
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Server Administration and User Management
Requirements for any computers that will be used for Server Administration or User Management. These
applications can be run remotely.
n Internet Explorer 10 or later or Microsoft Edge (for administering the server from Windows), Safari 7 or

later (for administering the server from a Macintosh), or the current release of Firefox or Chrome.
n An Internet connection and one of the above browsers to view Help.
n The current release of Adobe Flash® Player.

Reports
Reports can be viewed from any supported desktop browser.
n Internet Explorer 10 or later (for viewing reports from Windows 7 or later), or
n Microsoft Edge (for viewing reports from Windows 10), or
n Safari 9 or later (for viewing reports from OS X), or
n The current release of Firefox, or
n The current release of Chrome.



- 10 -

Installation Overview
The following is a general overview of the steps required to install and configure Universal Type Server.

1. Verify server system requirements.
Make sure your server meets or exceeds the specifications found at the Product Support page
(https://www.extensis.com/support/universal-type-server-6/).

2. Run the installer on the target server computer.
You can download the latest version of the installer from the Product Support page
(https://www.extensis.com/support/universal-type-server-6/). For detailed installation
instructions, see Installing Universal Type Server on the next page.
Note that you do not need to install the software on the server's boot partition.

3. Log in to the Server Administration application.
The Server Administration application is browser-based; it will start automatically when the
installation is complete. To start it yourself, see Opening the Server Administration application on
page 14.

4. Enter your Universal Type Server serial number.
See Universal Type Server Serial Numbers on the next page.

5. Set the Bonjour Name (optional).
Bonjour makes it easy for users to find your Type Server. See Setting the Bonjour Name on page 23.

6. Check for and resolve port conflicts.
Universal Type Server requires several open ports for communication; if any of these are in use by
other software then you will need to change them. See Resolving Port Conflicts on page 19.

7. Set any desired server configuration options.
This could include:
l Defining a Backup Plan (see Defining a Backup Plan on page 29);
l Configuring Log Files (see Log Files on page 15);
l Any other necessary server settings.

After installing the server, open the User Management application. From here, you can configure
workgroups and roles, then add users. These topics are covered in the User Management Guide and help
system.

https://www.extensis.com/support/universal-type-server-6/
https://www.extensis.com/support/universal-type-server-6/
https://www.extensis.com/support/universal-type-server-6/
https://www.extensis.com/support/universal-type-server-6/
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Installing Universal Type Server
Before installation, ensure that your server meets all of the minimum system requirements.

Copy the installer onto the server’s hard disk, double-click to launch the installer and follow the instructions.

For any late-breaking changes to the product, see the Universal Type Server Release Notes. These notes can
be accessed from the Product Support page (https://www.extensis.com/support/universal-type-
server-6/).

After the installer runs, the installation application starts your web browser and opens the Server
Administration application.

NOTE

You can administer the server using a web browser on a remote computer.
Enter the server’s IP Address into your browser’s address field followed by a
colon and the port number 18081. If this port is already in use on your server,
a random port is assigned. To obtain the port number, use the command line
tool; see Viewing Server Settings with the Command Line Tool on
page 59.

In the Server Administration application, log in using the default Server Administrator username and
password:

Server Administrator username: administrator
Server Administrator password: password

You should change the password in the User Management application before adding any other users to the
Type Server.

Universal Type Server Serial Numbers
Universal Type Server is licensed on a concurrent user model: your license allows a certain number of users to
connect at the same time (concurrently).

To begin using Universal Type Server, you must first enter your product’s serial numbers using the Server
Administration application.

NOTE: Your serial numbers are listed in your product receipt email and are also available by logging in to
your account at the Extensis website (https://secure.extensis.com/loginpage).

To serialize the server:
1. Log in to the Server Administration application.
2. Click Licenses.
3. Enter the Client serial number into the field and click Add Serial Number.
4. If you have a license for Type Core Clients, enter that serial number and click Add Serial Number.
5. If you have an Enterprise license, enter that serial number and click Add Serial Number.

Modules
Universal Type Server allows you to extend functionality with add-in Modules.

Typically, you will need to license your server and install the module on the Universal Type Server system
before you can enter the license for the module.

See the details for your specific module for complete installation and licensing instructions.

https://www.extensis.com/support/universal-type-server-6/
https://www.extensis.com/support/universal-type-server-6/
https://www.extensis.com/support/universal-type-server-6/
https://secure.extensis.com/loginpage
https://secure.extensis.com/loginpage
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Uninstalling Universal Type Server
Removing Universal Type Server removes all of the Type Server application files, but leaves your font
repository and any backup files on the server.

To remove the Universal Type Server application on Mac OS X:
1. In the Finder, navigate to Applications/Extensis/Universal Type

Server/applications/.
2. Double-click the Uninstall Universal Type Server application icon and follow the instructions.
3. To remove the font repository and backup files from the default install location, move all files in the

Applications/Universal Type Server/ folder to the Trash.

To remove the Universal Type Server application on Windows Server 2012:
1. Choose Start > Control Panel.
2. Click Programs, then click Programs and Features.
3. Select Universal Type Server.
4. ClickUninstall.
5. To remove the font repository and backup files from the default installation location, delete all files

from the directory Program Files/Extensis/Universal Type Server/.

NOTE

Your font repository and backup files may be in a custom location. You can
delete these files if you no longer need them.

Upgrading From a Previous Version

IMPORTANT

n Please run a complete backup before attempting your upgrade.
Users of Universal Type Server 5 can upgrade directly to version 6. Users
of earlier versions must upgrade to version 5 first.
Universal Type Server downloads are available from:
l Windows (http://bin.extensis.com/UTS-5-2-1-W.zip)
l Mac (http://bin.extensis.com/UTS-5-2-1-M.zip)

n The following procedure is appropriate for users who are currently using
the embedded Universal Type Server database. If you are upgrading to an
external SQL database, read the external database configuration
instructions for Converting Between Database Types on page 41.

Create a backup file
Before you begin the upgrade process, it is essential that you create a backup file of your current installation.

Newer versions of Universal Type Server use an upgraded database, so if you ever want to downgrade Type
Server to a previous version, this backup is required to complete the process.

Also, if you are moving to an external database, this backup file is used during the upgrade process.

http://bin.extensis.com/UTS-5-2-1-W.zip
http://bin.extensis.com/UTS-5-2-1-W.zip
http://bin.extensis.com/UTS-5-2-1-M.zip
http://bin.extensis.com/UTS-5-2-1-M.zip
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To backup your current Universal Type Server to your current backup location:
1. Open your web browser and start the Server Administration application.
2. UnderDatastore on the left, click Backups.
3. Note your current backup location, and click Backup now.

Install Universal Type Server
The Universal Type Server installer automatically removes your previously installed server, while keeping all of
your fonts, users and data intact.

1. Copy the new Universal Type Server installer to your server and double-click to run.
2. Follow the prompts to install the server upgrade.

NOTES

n During the upgrade process, all users will be disconnected and the server
will be placed in Standby mode. After upgrading the server, change the
Access State to Normal. Users will need to log in to the Type Server again.

n The database upgrade might take some time to finish. When complete,
the server automatically starts and is ready for users to connect.

After the installation is complete, serialize the server with your serial number.

You are now ready to configure an external database and connect to Directory Services as required.

Deploy new Universal Type Client
The new version of Universal Type Server includes a new version of Universal Type Client. If you have
deployed Universal Type Client 5, you can allow your users to continue with this version. However, many
new features and performance enhancements will not be available if you do not upgrade users to the latest
client. This is especially true if you are going to rely on Type Server to report on font activity or enforce font
license compliance: older Type Clients do not provide the information that Type Server requires for these
features.

If you are still using Universal Type Client 4, you must update users to a newer version; we recommend
updating to the latest version of Universal Type Client 6.

You do not need to upgrade users all at once, but we strongly recommend that you upgrade users to the
latest Universal Type Client at your earliest convenience.
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Server Status
Opening the Server Administration application
The Server Administration application is where the Server Administrator is able to:
n start, stop, and pause the server;
n change the server’s Bonjour name;
n examine and change port settings;
n manage memory allocation;
n view connected clients;
n configure and restore backups;
n locate, move, or create a new datastore;
n manage server serial numbers.

To log in to the Server Administration application:
1. Open a supported web browser.

Recent versions of most popular browsers with the latest Adobe Flash plug-in are supported.
2. In the address field, enter your server IP address followed by a colon and the port number. The default

server administration port is 18081 (also called the Web Admin port). For example:
http://192.168.0.1:18081 or http://localhost:18081.

3. Enter the administration username and password. The default Server Administrator username and
password are administrator and password.

NOTES

n The Password field is case-sensitive, but theUsername field is not.
n It is very important to change the Server Administrator password as soon

after installation as possible.
n The default location of the User Management application is the same IP

address, with the port number 8080. For
example: http://localhost:8080
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Log Files
The Universal Type Server creates log files to help identify and troubleshoot potential issues with the server.

These files include records of the following transactions, as well as other information:
n User login and logout
n The IP addresses of connected users
n The addition and deletion of workgroups
n The addition and deletion of users
n Server startup
n Server shut down
n Database backup, restoration, and changes to backup settings
n Database deletion
n Changes in database location
n Changes in log file location

On Windows, the default location for log files is:
Program Files\Extensis\Universal Type Server\Logs

On Mac OS X, the default location for log files is:
Applications/Extensis/Universal Type Server/Logs

These are the logs that are important for server administration:

Log file name Purpose

extensis.admin.log Contains all log messages displayed in the Server Activity window of the Server
Administration Status page.

extensis.server.log This is the main server log. Changing the server logging level affects what is recorded in this
file.

server.log Contains very verbose logging of server activity.

boot.log This log is created by JBoss upon startup. If JBoss is having problems at launch time, this
file can provide useful diagnostic information.

Changing the Logging Level
The contents of the main Universal Type Server log file, extensis.server.log, can be updated based on
how much detail that you need.

The logging levels available are:

Log Level What Gets Logged

ERROR Displays only error messages.

WARN Displays only error and warning messages.

INFO This is the default logging level and includes a wide variety of information about server activity.
This level is recommended for most installations.

DEBUG This level of logging includes very detailed information about your server and can result in very
large log files. Itis not recommended unless specifically requested by your support
representative.
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To change the server logging level:
1. Open the Server Administration application (see Opening the Server Administration application on

page 14).
2. Click Logging.
3. Choose a new level from the Logging level drop-down menu, then clickUpdate Server.

Changing the Log Location
Administrators can change the location where the main Universal Type Server log file,
extensis.server.log, is placed.

To change the log file location:
1. Open the Server Administration application (see Opening the Server Administration application on

page 14).
2. Click Logging.
3. Enter a new log location into the Logging directory field. The default location is in the logs folder

of the Universal Type Server application folder. The following are examples of new paths:
Windows: C:\Universal Type Server\logs
Macintosh: /Volumes/Macintosh HD/logs

NOTE

The new logging directory folder must already exist on the disk. Creating log
files on a network location is not supported. Enter the full path, do not use
relative paths, and include a drive letter on Windows.

4. ClickUpdate server.

A new extensis.server.log file is created in the new location. The log file in the previous location is
not removed, but it is no longer updated.

All other Universal Type Server log files always remain in the default location, and the location cannot be
changed. If removed, they are automatically recreated by the server.

Changing Log Backups
The extensis.server.log file is backed up on a daily basis at 12:15 a.m. to your designated logging
location. Log backup files are named with the log file name followed by the date of the backup, and they
can be opened with any text editor or word processor.

Since these files can become very large, you may not want to keep a significant number of them on the
server. By default, the server keeps the 10 most recent log files.

To update the number of log backups to keep:
1. Open the Server Administration application (see Opening the Server Administration application on

page 14).
2. Click Logging.
3. Enter the number of backups to keep in the Retained server logs field and clickUpdate server.
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Ports
The Universal Type Server requires a number of ports on your server. These ports are used for client
connection, server administration as well as internal server communication.

Port Default

UTS HTTP / Web Service 8080

UTS HTTPS / Web Service 8443

UTS CLI 9999

Web Admin HTTP 18081

Web Admin CLI 19999

Report Service 8880

All ports used with Universal Type Server must not conflict with other applications on the server.

External ports must be opened in the host system’s firewall and operating system. The process of opening
ports varies by operating system. Please refer to the Mac OS X Server and Microsoft Windows
documentation for more information.

NOTE: The Report Service port is not included in the Server Administration application’s Ports page. If
you have a conflict with the default port, contact Extensis Technical Support for assistance. (See Technical
Support on page 75).

Ports for External Communication
The Universal Type Server requires three ports to be open for server administration and client connection.
n UTS HTTP/Web Service port: Default port number 8080
n UTS HTTPS/Web Service port: Default port number 8443
n Web Admin port: Default port number 18081

These ports are used on a regular basis and are listed on the Server Administration Ports page.

IMPORTANT

If you are configuring a Primary and Secondary server in a failover
configuration, be sure the ports are set to the same values on both systems.
See Configuring Automatic Failover Services on page 42 for more
information.

UTS HTTP/Web Service port
This is the port where users connect to your server, as well as the port where administrators open the User
Management application. The default port setting is 8080.

Client connections
Clients require the following information for server login:
n The server IP address, DNS name or Bonjour name.
n The UTS HTTP / Web Service port number. If using a Bonjour name, a port is not required.
n Client account name and password.
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User Management
To connect to the User Management application, enter the server IP address in the address field of any
supported browser followed by a colon and the port number.

For example: http://123.45.34.12:8080/

UTS HTTPS/Web Service port
When the secure connection option is enabled, administrators connect to the User Management
application through the UTS HTTPS/Web Service Port.

The default setting for this port is 8443.

The port for secure connections is only used to connect with the User Management application. With
secure connections enabled, when administrators attempt to connect with the UTS HTTP/Web Service
port, they are automatically redirected to the UTS HTTPS/Web Service port.

For example, an administrator can enter http://123.45.34.12:8080 and be redirected to
https://123.45.34.12:8443, or enter https://123.45.34.12:8443 directly.

Web Admin port
This port is used to open the Server Administration application. Enter the server IP address followed by a
colon and the port number in the address field of a supported web browser. The default port setting is
18081.

Example: http://123.45.34.12:18081/

Ports for Internal Server Communication
A number of standard Java J2EE and web service ports must be reserved for the internal communication of
Universal Type Server.

It is possible that you may have other applications running or requiring Java on your server. Type Server runs a
self-contained version of Java, so it is possible to run other Java and web service applications on the same
computer, provided that you resolve any port conflicts.

To avoid conflicts, use the Ports page to assign new port numbers for Type Server.

The following ports are required for internal Universal Type Server communication:

Port Default

UTS CLI 9999

Report Service 8880

NOTE: The Report Service port is not included in the Server Administration application’s Ports page. If
you have a conflict with the default port, contact Extensis Technical Support for assistance. (See Technical
Support on page 75).
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Resolving Port Conflicts
The Universal Type Server installer checks to see if the default server administration port 18081 (Web Admin
Port) is bound to any other application. If it is already taken, then another port is chosen randomly before
the Server Administration application starts.

All other ports listed on the Server Administration’s Ports page are required for proper operation of the
server. Type Server checks for any port conflicts and lists them in the extensis.admin.log. The server
uses standard JBoss ports, so if your server has other applications that are built using this technology, you
may need to change the default Type Server port numbers.

NOTE: The Report Service port (default 8880) does not have an entry on the Ports page. If you have a
conflict and need to change this port’s value, contact Extensis Technical Support (see Technical Support
on page 75).

To update port numbers:
1. Open the Server Administration application (see Opening the Server Administration application on

page 14).
2. Under Settings on the left, click Ports.
3. For each port that requires a new port number, enter a new port number or click Find port to locate

an open port.
4. ClickUpdate Ports.
5. Restart the server (see Stopping, Starting, and Restarting the Server on page 22).

Opening Ports in the Windows Firewall
To open ports for server administration and client connection:

1. Open the Windows Control Panel.
2. Double click the Windows Firewall icon.
3. Click the Change Settings option.
4. If prompted, click Continue to allow this action.
5. Click the Exceptions tab of the Windows Firewall Settings dialog, then click Add Port.
6. In the Add A Port dialog, enter the following information and clickOK.

l Name: Universal Type Server User Management
l Port: 8080
l Protocol: TCP

7. Click Add Port again to add a second port. Enter the following information and clickOK.
l Name: Universal Type Server System Administration
l Port: 18081
l Protocol: TCP

8. ClickOK to accept the new settings.

Security Concerns
The Universal Type Core communicates with the Type Server using HTTP through the JBoss HTTP port (see
Ports for External Communication on page 17).

All client and server login usernames are sent as clear text via HTTP. For security reasons, all associated
passwords are encrypted and sent using the MD5 cryptographic hash function.

For additional security, Extensis recommends that the Type Server run behind a firewall using authentication
through the required external ports (see Ports for External Communication on page 17).
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Implementing a Secure Connection
A secure connection provides encrypted communications between Universal Type Server and the computer
that is used to administer the server.

A redirect to the secure connection port is not enabled by default. A secure connection can be enabled using
the default, self-signed certificate, or with a custom security certificate for your organization.

NOTE

Enabling a secure connection will cause a slight performance degradation in
the User Management application. This setting does not affect your client
users in any way.

Enabling a secure connection requires the following steps:
1. Obtain a custom security certificate.
2. Edit the standalone.xml file with your custom security certificate password.
3. Enable the automatic redirect to the secure connection by editing the web.xml file.

Obtain a Security Certificate
Security certificates tell the web user that the secure connection is valid and can be trusted. Typically these
certificates are issued by trusted organizations. If desired, obtain a security certificate for your organization.

Universal Type Server includes a default, self-signed security certificate. This certificate allows you to create a
secure connection without obtaining your own custom certificate. Using the default certificate will cause
your browser to display a number of security warnings when you open the User Management application.
These warnings indicate the nature of the self-signed certificate, but by using it you can still create a secure
connection with the Type Server. All browsers allow you to record a security exception or to trust the self-
signed certificate. See your browser’s documentation for details.

If you choose to obtain a custom security certificate, you can obtain a one from Verisign
(http://www.verisign.com/ssl/), GoDaddy (http://www.godaddy.com/ssl/ssl-certificates.aspx),
or other Certificate Authority.

After obtaining the certificate, rename the file to uts.keystore and use it to replace the default
certificate in the following location on your server:

Windows: C:\Program Files\Extensis\Universal Type
Server\applications\jboss\standalone\configuration\uts.keystore

Macintosh: /Applications/Extensis/Universal Type
Server/applications/jboss/standalone/configuration/uts.keystore

http://www.verisign.com/ssl/
http://www.verisign.com/ssl/
http://www.godaddy.com/ssl/ssl-certificates.aspx
http://www.godaddy.com/ssl/ssl-certificates.aspx
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Edit the standalone.xml file
Editing the standalone.xml file enables the secure connection by editing the security certificate name,
password, and location.

To add the security certificate:
1. Open the standalone.xml file from the following location with a text editor such as Notepad or

TextEdit.
Windows: C:\Program Files\Extensis\Universal Type

Server\applications\jboss\standalone\configuration\standalone.xml
Macintosh:/Applications/Extensis/Universal Type

Server/applications/jboss/standalone/configuration/standalone.xml
2. To change the name and location of your security certificate, search for the certificate-key-

file value. Edit the value between the quote marks to match your security certificate file name. If
you renamed your security certificate to the default name, uts.keystore, and placed it in the
default location, you can leave this value as is.
For example, the default entry in standalone.xml looks like this: certificate-key-
file="${jboss.server.base.dir}/configuration/uts.keystore"
If you have moved the security certificate file, enter its complete path between the quote marks.
Windows example: certificate-key-file="C:\Users\me\certificates\my_uts_
cert.keystore"
Macintosh example: certificate-key-file="/Users/me/Documents/my_uts_
certificate.keystore"

3. To enter the password of your security certificate, search for the password entry. Edit the value
between the quote marks to match your security certificate password.
password="uts_ssl"

4. Save and close the standalone.xml file.

Enable a Redirect to the Secure Port
Editing the web.xml file enables a redirect from the standard web service port (default port 8080) to the
secure connection port (default port setting 8443).

To enable the redirect:
1. Open the file from the following location with a text editor such as Notepad or TextEdit.

Windows: C:\Program Files\Extensis\Universal Type
Server\applications\jboss\standalone\deployments\uts.ear\uts.war\WE
B-INF\web.xml

Macintosh: /Applications/Extensis/Universal Type
Server/applications/jboss/standalone/deployments/uts.ear/uts.war/WE
B-INF/web.xml

2. Use the search feature to locate the line that contains the transport-guarantee parameter.
Change the following line from:
<transport-guarantee>NONE</transport-guarantee>
to:
<transport-guarantee>CONFIDENTIAL</transport-guarantee>

3. Save and close the web.xml file.
4. You will need to restart your Universal Type Server for the change to take affect.
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Automatically Starting the Server
If you need to restart the physical server, the Autostart preference must be enabled for the server to
automatically launch and serve fonts to clients.

The Autostart preference is enabled by default, but may be disabled if desired depending upon your server
configuration.

To enable the Autostart preference:
1. Open the Server Administration application (see Opening the Server Administration application on

page 14).
2. Click System.
3. Choose Autostart > Enabled.
4. ClickUpdate server.

If the Autostart preference is disabled, administrators are still able to connect to the Server Administration
application to start the server.

Placing the Server in Standby Mode
Placing the server in standby mode prevents any non-administrative users from performing any actions that
require communication with the Universal Type Server. The server runs normally for administrative users.

When in Standby Mode, all client users are not logged off, but are placed in offline mode. While in offline
mode, users are only able to activate and preview files that are in their local cache. Font files that are not
available for user are displayed in red in the Universal Type Client.

When performing datastore backups and restores, the Type Server automatically changes to standby mode
before performing the required administrative task, and then changes back to normal mode when the task is
complete.

To place the server in standby mode:
1. Notify users of your intention to place the server in standby mode.
2. Open your web browser and start the Server Administration application.
3. Click System.
4. Choose Access state > standby.
5. ClickUpdate server.

The server will be placed in standby mode.
6. Perform any necessary server maintenance.
7. Click System.
8. Choose Access state > normal.
9. ClickUpdate server.

The server resumes normal access and displays the Status page when complete.

Stopping, Starting, and Restarting the Server
If you need to stop, start, or restart Universal Type Server, use the Server Administration application. This
ensures that all processes are properly shut down and restarted.

When you shut down the server, connected clients are automatically put in Offline mode. This means that
client computers will only have access to fonts that are cached locally on their computer. Which fonts are
cached depends mostly upon the font replication mode that is enabled for each user. See the User
Management Guide for more information.
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Before you shut down or restart your Type Server, we recommend that you notify users so they can prepare
to work offline.

To stop Universal Type Server:
1. Start your web browser and connect to the Server Administration application (see Opening the

Server Administration application on page 14).
2. Under Settings on the left, click System.
3. Choose Running state > stopped.
4. ClickUpdate server.

When the server has stopped, the Status page will be displayed.

To start the server:
1. Start your web browser and connect to the Server Administration application.
2. Click System again.
3. Choose Running state > started.
4. ClickUpdate server.

When the server has finished starting, the Status page will be displayed.

To restart the server:
Follow the steps above to stop the server, then follow the steps to start the server. Be sure the Status page
shows the server has stopped before attempting to start it.

Starting automatically
If you need to restart the physical server hardware, you should enable the Autostart preference (see
Automatically Starting the Server on the previous page) for the Type Server to automatically launch and
serve fonts to clients. If this preference is disabled, you will need to start the Type Server manually.

Setting the Bonjour Name
Bonjour is a technology from Apple Inc. that enables users to easily locate Universal Type Server on the
network. Bonjour technology is built into Mac OS X, and is installed by the Universal Type Client installer for
clients using Microsoft Windows.

When users connect to the server, they only need to know the server’s Bonjour name, their username, and
their password to connect.

To set the Universal Type Server Bonjour name:
1. Open the Server Administration application (see Opening the Server Administration application on

page 14).
2. Click System.
3. Enter a Bonjour Name into the field. If you have more than one Type Server, choose as specific a

name as possible.
4. ClickUpdate server.
5. Restart the server (see Stopping, Starting, and Restarting the Server on the previous page).
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To test the new Bonjour name:
1. Launch the Universal Type Client.
2. If the client is currently connected to a server, choose File > Server > Forget Connection.
3. In the Connect to Server dialog, choose Server > Browse Local Servers.
4. Select your new Bonjour name from the list and clickOK.
5. Enter your username and password and click Connect.

Memory allocation
If you are using Universal Type Server with a large number of LDAP users or a large number of workgroups,
you may find it necessary to increase the amount of memory available to the Type Server. This is especially
important if your server logs have Java Heap Space errors.

To change the server memory allocation:
1. Click System.
2. Enter the amount of memory for the Java Virtual Machine in the Memory Allocation field.

IMPORTANT: Select a size that is lower than the amount of physical memory in the server system.
For example, if your server has 8GB of RAM, do not attempt to allocate more than 6GB to the Type
Server.

3. ClickUpdate server.

The Universal Type Server will restart.

Locking Server Administration
The Server Administration application automatically logs you out after a period of inactivity. Sometimes you
may want to continually monitor the server status, and not automatically be logged out. For example, you
might want to keep the Status page displayed on a server room monitor.

Locking the status page does not prevent other users from accessing the Server Administration application
from another computer.

To lock the Server Administration Status page:
1. Open the Server Administration application (see Opening the Server Administration application on

page 14).
2. In the Status area, click the Lock icon.

To unlock the server, click the lock icon and log in.
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Client Connections
Viewing Connected Users
Administrators can view a high level list of connected users in the Users page of the Server Administration
application. This list provides the login User Name, Full Name, IP Address, and Login Date.

You can sort the list of users by any field by clicking the sort icon at the top of each column.

If you are using both traditional Type Client and Core Client connections in your configuration, users can be
filtered by client type. Choose:
n User Type > All to display both Type Client and Core Client conenctions.
n User Type > Full to display only Type Client connections.
n User Type > CoreClient to display only Core Client connections.

To update the number of connected users visible at a time, enter a new number in the Users per page
field and clickUpdate page size.

For more complete user management, including adding and removing users, open the User Management
application.

Forcing User Disconnection
In some instances, you may need to force the logout of a currently connected user.

For example, if you are currently using all of your license seats, you may need to force the logout of one user
to allow another user to connect. In another instance, you may need to force the logout of a recently
terminated employee. You would of course also want to delete the user account of any terminated
employee using the User Management application.

To force user logout:
1. Open your web browser and start the Server Administration application.
2. ClickUsersin the menu at the left.
3. Check the boxes for the users that you want to disconnect. To select all users on the current page,

check the box at the top of the first column.
4. Click Force Logout Selected Users.

When you force the logout of a user, it is the same as the user selecting Server > Forget Connection.
After forcing the logout of a user, the next time the client attempts to synchronize with the server the
connection is terminated and all server fonts are removed from the client.
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Datastore
Creating a New Datastore

WARNING

When you create a new datastore, your current datastore will be deleted. You
may wish to back up your existing datastore and move it to a safe location
before you create a new one. For instructions, see Backing Up the
Datastore on page 29.

The datastore consists of two parts: the database and the vault. The database location is fixed (whether you
are using a native database or a SQL-based external database), but the vault can be moved to a new
location.

The default location for the vault depends on your operating system:
n Windows: C:\Program Files\Extensis\Universal Type Server\data\vault
n Mac OS X: /Applications/Extensis/Universal Type Server/data/vault

For details about specifying a new vault location, see Vault Location Requirements on the next page.

To create a new datastore:
1. Log in to the Server Admin application.
2. ClickMove/New underDatastore in the navigation menu on the left.
3. Enter the full path where you want to create a new vault in the field labeledNew repository

location.
Universal Type Server will create any folders that don’t already exist.
NOTE: The database component of the datastore is always in the same location, regardless of
whether you are using the built-in database or a SQL-based solution.

4. ClickNew datastore.
5. ClickOK to confirm.

The Type Server will go in to standby mode, then it will automatically start when the operation is
complete.

After creating a new datastore, you will need to go through all of the standard configuration steps, including
creating workgroups and users.

IMPORTANT

If you create a new vault on a network share, that share must be accessible in
read/write mode to the account that your Type Server runs under. For
Universal Type Server installations on Windows, the share must be specified
with a UNC path, and the Type Server must be running under a domain user
account with full read/write access to the share. For Universal Type Server
running on OS X, the share must be specified as a POSIX path.
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Moving the Vault
The vault is the part of Universal Type Server's datastore that holds all the fonts hosted by your Universal
Type Server. Because it stores a copy of each unique font, your vault can become very large.

The vault is initially created on the same volume where you installed Universal Type Server. If you think that
your vault will need more space, you can move it to a new drive.

Moving the vault can take several minutes, depending on how big it is. You should move it when users don't
need to access your Universal Type Server.

Vault Location Requirements
The new location for the vault must:
n Be specified by the full path to the vault folder (not a relative path such as ..\path_to_vault);
n Always be accessible to the Universal Type Server;
n Grant read/write access to the computer account under which Type Server runs;
n Be specified by a UNC path (Windows) or a POSIX path (Mac OS X) if it is on a network volume.

You should use a folder dedicated to the vault, because Universal Type Server will create several folders inside
it. We suggest naming the vault folder “vault.”

Be aware that if you locate your vault in a folder that others use, anyone that has access to that folder may
inadvertently corrupt the vault’s contents.

WARNING

n You should only move your vault to a network location if you are using a
failover configuration (see Configuring Automatic Failover Services on
page 42).

n You should not move your vault to a local volume that is removable (such
as an external USB drive).

Windows vault path examples
C:\Users\jsmith\documents\vault\

D:\shared_files\font_vault\ (D: is a local drive)

\\NetworkFiles\Design\vault\ (NetworkFiles is the server name, Design is a shared volume
on the server, and vault is the vault folder)

Mac vault path examples
/Users/jdoakes/font vault (Universal Type Server should be running under the jdoakes login
account)

/Volumes/Marketing/misc/vault (Marketing is a shared network volume, misc is a folder on
the volume, and vault is the vault folder)

If you are running Universal Type Server on Windows:
n If you are using a network volume to store your vault, do not use a mapped drive path (such as

Z:\path_to_vault) as the path you enter in Universal Type Server. Instead, use the complete UNC
path (such as \\remote_server\shared_volume_name\path_to_vault).

n Universal Type Server must be running under a domain user account that has full read/write access to
the network vault location.

n If your vault is located on a Mac OS X system, be sure to enable Windows (SMB) sharing for the vault.
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If you are running Universal Type Server on Mac OS X:
n If you are using a network volume to store your vault, enter the POSIX path to your vault (such as

/Volumes/shared_volume_name/path_to_vault) in Universal Type Server.
n If you mount more than one network volume with the same name as the volume that your vault is on

(shared_volume_name in the example above), be aware that the order in which the volumes are
mounted may make it impossible for Universal Type Server to find your vault. To be safe, only mount
volumes with unique names. If you must mount network volumes that have identical names, be sure to
always mount your vault’s volume first.

To move your vault to a new location:
1. Log in to the Server Admin application.
2. ClickMove/New underDatastore in the navigation menu on the left.
3. Enter the full path where you want to move the vault in the field labeledNew location for vault.

Universal Type Server will create any folders that don’t already exist.
4. ClickMove vault.

The Type Server will go in to standby mode, then it will automatically start when the operation is
complete.



- 29 -

Backing Up and Restoring
Defining a Backup Plan
As you set up Universal Type Server, it is important to define an effective datastore backup plan. This ensures
that, in cases of emergency, your datastore is safe and can be restored.

The Universal Type Server datastore contains all of the fonts, as well as all user, workgroup, and server data.
Backup files are rolled into a single, date-stamped .TAR file. TAR files are archive files like the ZIP files created
by your operating system.

It is recommended that you back up your datastore at least once per week. Plan to store copies of the
backup in an offsite location from time to time. This ensures that if anything happens to the local copies of
the files, you can restore from the offsite backup.

For the highest level of data security, it is best to keep multiple backup files. Universal Type Server is able to
automatically create and retain however many backup files that you need, and subsequently remove any
out-of-date backups.

Backups can be performed manually, but it is much easier to define a schedule and allow Universal Type
Server to automatically create files.

IMPORTANT

Backups must be created in an existing folder location on the Universal Type
Server computer. Backing up the server to network locations, including NFS-
mounted or UNC accessible paths, is not supported.

In case of any hardware failure or other incident, a backup can be easily restored to a new server install
location using the Server Administration application.

Backing Up the Datastore
While you can back up Universal Type Server’s data using other software, we recommend that you use the
built-in backup utility. This allows you to quickly restore or replicate an entire Universal Type Server database,
including all fonts and user information, on a new system if you need to.

You can back up the server manually or configure Universal Type Server to perform automatic backups at
regular intervals.

To manually back up the datastore:
1. Open your web browser and start the Universal Type Server Administration application.
2. UnderDatastore in the menu on the left, click Schedule backups.
3. Enter a local backup destination into the Backup destination field.

The default location for the datastore is the data\backups folder of the Universal Type Server
application folder.
Enter the full path; do not use relative paths, and be sure to include a drive letter on Windows.
The following are examples of appropriate paths:

Windows: C:\Universal Type Server\backups
Macintosh: /Volumes/Macintosh HD/backups

4. ClickUpdate server.
5. UnderDatastore in the menu on the left, click Backups.
6. Click Backup now.
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To configure automatic backups:

NOTE

For automatic backups, it is best to set backup times when most users are not
connected to the server. When the server is performing a backup, users are
not disconnected, but are unable to synchronize with the server until after the
backup is complete.

1. Open your web browser and start the Universal Type Server Administration application.
2. UnderDatastore in the menu on the left, click Schedule backups.
3. Enter a local backup destination into the Backup destination field.

The default location for the datastore is the data\backups folder of the Universal Type Server
application folder.
Enter the full path; do not use relative paths, and include a drive letter on Windows.
The following are examples of appropriate new paths:

Windows: C:\Universal Type Server\backups
Macintosh: /Volumes/Macintosh HD/backups

4. Enter the number of backup files to retain in the Retained backups field.
For the highest level of data security, it is a good idea to keep multiple backups.

5. Choose the time and days for backing up that will cause the least amount of user disruption.
6. ClickUpdate server.

After setting automatic backups, be sure to make a note of the times when you should also be moving
backup files off the server to a secure, offsite location.

Restoring a Backup
In the case of hardware failure or other issues, a backup datastore can be restored. The backup contains all
fonts, users, workgroups, and all other settings to restore your datastore to the backed-up state.

WARNING

Restoring a backup overwrites your current datastore. All connected users are
automatically logged out, and will need to reconnect.

To restore a backup:
1. Open your web browser and start the Server Administration application (see Opening the Server

Administration application on page 14).
2. UnderDatastore on the left, click Backups.
3. Enter the full path and filename of the backup file in the Restore field.

Enter the full path; do not use relative paths, and include a drive letter on Windows.
The following are examples of appropriate paths:

Windows: C:\Universal Type Server\backups\2008_02_18T10_00_00_156Z.tar
Macintosh: /Volumes/Macintosh HD/backups/2008_02_18T10_00_00_156Z.tar

4. Click Restore datastore.
5. ClickOK to confirm the restore.
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Client Administration
Most Universal Type Client information can be found in the Universal Type Client User Guide as well as the
Type Client help system.

It’s important to note that all font administration, including adding and removing fonts, is done directly in
the Universal Type Client.

Universal Type Client System Requirements
For the most up-to-date information about the latest release of Universal Type Client, please visit the
Product Support page (https://www.extensis.com/support/universal-type-server-6/).

Macintosh Universal Type Client
n OS X® 10.8 through 10.13
n 2.0 GHz or faster processor
n 1 GB available hard drive space for application files, plus additional space for fonts
n 100 Mbit/s or faster network connection
n An Internet connection and Safari® 7 or later or the current release of Firefox® or Chrome™ to view

Help

Windows Universal Type Client
n Windows® 7, Windows 8, Windows 8.1, or Windows 10
n 2.0 GHz or faster processor
n 1 GB available hard drive space for application files, plus additional space for fonts
n 100 Mbit/s or faster network connection
n An Internet connection and Internet Explorer® 10, Microsoft Edge, or the current release of Firefox or

Chrome to view Help

You need to have Internet Explorer installed in order for QuickComp to work properly. It does not need to be
your default browser.

The Universal Type Client Cache
Each client system stores fonts and other client data locally in a cache folder. This includes all necessary
server fonts as well as items in client-based personal workgroups.

When a user chooses Server > Forget Connection, any font files cached in the Type Client cache are no
longer available for use on that system.

If a user chooses Server > Go Offline, fonts are available depending on their font replication mode
setting.
n All: The user has access to all fonts in their workgroups.
n On-Demand Local Cache: The user has access to any fonts that they have previously used. Any fonts

that they have ever previewed or activated reside in the cache.
n On-Demand: The user has access to the fonts that are active on their system before going offline.

https://www.extensis.com/support/universal-type-server-6/
https://www.extensis.com/support/universal-type-server-6/
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The Type Client cache consists of two components, the database and the type cache:
n The type cache is the storehouse for all fonts downloaded from the server. The cache’s structure varies

by platform. For the Mac OS X client, the UniversalType.typecache file is a bundle that contains
all fonts. On Windows, font files are stored within a directory named cache.

n UniversalType.db contains all of the database information, such as font and workgroup details and
client permissions. It is stored within the UniversalType.typecache bundle.

WARNING

Deleting or moving any part of the client cache may render the application
inoperable. Contact Extensis Technical Support before attempting to alter the
client cache in any way.

The Type Client cache files are stored in the following locations:

Mac OS X: /Library/Extensis/UTC/<uid>/UniversalType.typecache/

The UserID (uid) is a unique number assigned by OS X to each user account. The first user account on the
computer is 501, followed by 502, 503, and so on. To determine the uid for the current user, open a
Terminal window and enter the id command.

Windows 7, 8, 8.1, and 10: C:\Users\<username>\AppData\Local\Extensis\UTC\cache\

To open this directory on Windows 8, 8.1, or 10, pressWIN+X to open the system menu, click Search,
type the environment variable %LOCALAPPDATA%, then press ENTER.

To open this directory on Windows 7, click the Startmenu, type %LOCALAPPDATA% into the Search
field, then press ENTER.
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Disabling Other Font Managers
To ensure the proper operation of Universal Type Client, it is important to disable or uninstall any other font
managers.

Just closing or quitting other font managers might not be sufficient. Many font mangers, including the
Universal Type Client, run an application in the background that manages font activation and deactivation.
These background applications must be disabled before running the Type Client. To do so, check for an
application preference that tells the other application to open on startup or login and then restart your
computer.

On Mac OS X, it is important to disable two preferences within the Font Book application. The following
preferences affect system behavior and can interfere with Universal Type Client:
n Automatic font activation: This option interferes with professional font mangers and does not

allow for automatic font activation across all applications. The Universal Type Client still allows you to
use plug-in based automatic activation for each supported application. This option is present in all
versions of Font Book.

n Alert me if system fonts change:When enabled, this option will automatically place “protected”
fonts back into your system font folders even if you remove them. It also can prevent a professional font
manager from effectively managing or overriding your system fonts. This option is only present in Font
Book versions included with OS X 10.8 and earlier.

WARNING

Do not launch Font Book while using Universal Type Client. Remove it from
the Dock if necessary.

The Universal Type Core
The Universal Type Core is a background application that runs on the client computer. This application
handles all communication with the Type Server and makes it possible for the user to close the Universal
Type Client and still keep fonts active and automatically activate fonts. The Type Core handles all plug-in
based auto-activation requests and automatically implements any updated permissions, workgroup
changes, and all other changes upon synchronization with the server.

The Universal Type Core is started when the user logs in to their computer. You can stop the Type Core from
the Universal Type Client preferences.

To stop the Type Core:
1. Start the Universal Type Client.
2. Choose Universal Type Client > Preferences (Mac) or Edit > Preferences (Windows).
3. Click the FMCore tab in the Preferences dialog.
4. Click Stop FMCore.
5. When asked if you are sure, click Stop FMCore.

When you stop the Universal Type Core, font management is disabled, and all active fonts are deactivated.
Generally, the only fonts that will be available for use on the computer will be the fonts protected by the
operating system.
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Client License Management
Universal Type Server uses a machine-based licensing model. The number of client connections allowed is
encoded into your Type Server serial number.

You can see how many users are connected, the associated IP addresses, and unique computer
identification in the Users panel in the Server Administration application. The Licenses panel displays your
serial numbers, as well as the number of client connections allowed.

How client connections are counted
For environments where more than one user connects using the same computer, only one client license is
consumed. This allows an environment that may have many users on a computer during the course of the
day, such as educational institutions, to allow each user to connect, and even if each user does not choose
the Forget Connection command at the end of their session, the computer itself only consumes one
client license for the computer.

Conversely, if a user logs in to Universal Type Server from two separate computers, two client licenses are
required. For example, in an environment where every user has both a Mac and a PC, a client license is
required for each computer.

Automatic disconnection
Users who may spend long amounts of time working offline away from the server must connect to the
server at least once every 30 days or be automatically disconnected from the server. Once disconnected, the
client license is freed and available for another user. The disconnected user is no longer able to access fonts
through the Universal Type Client, and must reconnect to Type Server to regain access.

Client license overage
When the number of licensed clients is reached, any additional users who attempt to connect are not able
to do so. To forcibly disconnect a user to make that connection available for another user, select the user
from the Users panel of the Server Administration application and click Force Logout Selected Users.
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Enterprise Features
The Enterprise version of Universal Type Server provides extended capabilities for organizations with large
font management and compliance needs. The additional and enhanced features available to Enterprise
users are:
n External SQL database connection
n Automatic Failover Services
n Font license compliance enforcement
n Font usage and compliance reporting

Font usage and licensing is managed through the User Management application.

Upgrading to Enterprise
When you are ready to upgrade from Universal Type Server Professional to Universal Type Server Enterprise,
you should back up your datastore.

Click Licenses and enter your Enterprise Module serial number, then click Add Serial Number.

External SQL Database
Rather than store the Universal Type Server database in the native embedded database, Enterprise users
have the option to store all of the required data in an external SQL database. You may want to do this if:
n Your company maintains a dedicated database server for data management and centralization

purposes.
n You need to take advantage of the additional administration and performance tuning options in third-

party SQL databases that are not available in the embedded Type Server database.
n You require a distribution of hardware resources to improve the performance and scalability of your

server.

After configuring the connection to an external database, most administrative functions, and all client-level
interaction with Universal Type Server function the same as the native, embedded Type Server database.

External Database Requirements
Universal Type Server Enterprise supports the following SQL database servers:
n Microsoft SQL Server 2012 or 2014 (Windows)
n MySQL 5.5 or later (OS X or Windows)

NOTE: While it may be possible to use Universal Type Server with other versions of these databases, no
others have not been tested and cannot be supported.
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Hardware recommendations for an external SQL database
n For best performance, your database server should be configured on a separate server-grade computer

from your Universal Type Server.
n In general, faster processor cores, faster memory, a faster disk interface, faster hard disk, and faster

network connection will yield optimal performance.
n If possible, your database software and database should be installed on a separate physical disk from the

database server’s operating system.
n Follow these system requirements or recommendations for your particular database:

l Microsoft SQL Server 2012: http://msdn.microsoft.com/en-us/library/ms143506
(v=sql.110).aspx

l Microsoft SQL Server 2014: http://msdn.microsoft.com/en-us/library/ms143506
(v=sql.120).aspx

MySQL does not publish specific system requirements for the database server itself. See
http://dev.mysql.com/doc/workbench/en/wb-requirements-hardware.html for requirements for
the highly-recommended MySQL Workbench.

Installing an External Database
Install Universal Type Server
Before configuring the external database connection, install the Universal Type Server application, and then
proceed with the instructions below.

If you have previously installed and configured Universal Type Server, and prefer to upgrade your data, follow
the instructions for Converting Between Database Types on page 41. There is no need to re-install
Universal Type Server.

Install the database server and create a database
Install and configure your external database server. To get the benefits of an external database, we
recommend installing your database server on a separate system from Universal Type Server. While it is
possible to install the database server on the same hardware, the most benefit will be achieved from
separate hardware.

1. Install the database server following the manufacturer’s instructions.
2. Using the database administration interface or command line tools provided by your database server,

create a username and password for Universal Type Server to the new SQL database. In Microsoft
SQL Server, the username is called a “Login.” Choose SQL Server Authenticationwhen creating
your new login.

3. Create a new empty SQL database for the Universal Type Server datastore. The user that you created
in the previous step must be set as the database owner.

IMPORTANT

When creating the database, be sure to specify Latin1_General_BIN2
collation for MS SQL Server. For MySQL, leave collation as Server Default.

For detailed assistance setting up MySQL on Mac OS X, see Installing MySQL on Mac OS X on page 38.

http://msdn.microsoft.com/en-us/library/ms143506(v=sql.110).aspx
http://msdn.microsoft.com/en-us/library/ms143506(v=sql.110).aspx
http://msdn.microsoft.com/en-us/library/ms143506(v=sql.110).aspx
http://msdn.microsoft.com/en-us/library/ms143506(v=sql.120).aspx
http://msdn.microsoft.com/en-us/library/ms143506(v=sql.120).aspx
http://msdn.microsoft.com/en-us/library/ms143506(v=sql.120).aspx
http://dev.mysql.com/doc/workbench/en/wb-requirements-hardware.html
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Open a port in the firewall
If you are using a firewall on the computer that hosts the SQL server, you must open a port so that Universal
Type Server can connect to the SQL database.

The default SQL port for Microsoft SQL Server is port 1433.

The default SQL port for MySQL is port 3306.

This port can be changed in your database server to meet any specialized requirements.

Connect Universal Type Server to the empty SQL database
1. Open the Server Administration application (see Opening the Server Administration application on

page 14).
2. In the Datastore area, clickDatabase.
3. Click the Database Type drop-down menu and select your database server type.
4. Enter the following fields so that Universal Type Server can connect to the new database server.

Field Description

Server Address Either the DNS name or IP address of the computer hosting the database server.

Port The port used to access the external database server. The default Microsoft SQL Server
port is 1433, and for MySQL the default is 3306.

Database Name The SQL database name.

Username The username that you created for Universal Type Server to use. When using Microsoft
SQL Server, this is the “Login” name.

Password The password for the username above.

5. The Additional Parameters field is used to modify the behavior of the connections between
Universal Type Server and the SQL database server. The use of this field is relatively rare. If required,
enter any parameters provided by your SQL Database Administrator. The following table illustrates a
number of parameters that may be helpful. For more information about additional parameters, see
http://jtds.sourceforge.net/faq.html#urlFormat.

Parameter Usage Description

namedPipe namedPipe=[true,
false]

When set to true, named pipe communication is used to
connect to the database instead of TCP/IP sockets. This can
result in performance gains when the SQL Server is running on
the same computer as the Universal Type Server.

instance instance="<instance
name>"

Allows the Universal Type Server to connect to a named
instance of SQL Server.

6. ClickNew datastore to create the new datastore.

Verify database creation
After creating the new datastore, click Status in the Server Administration application. Check in the Status
window to verify that Universal Type Server has stopped and restarted. This is your indication that the
datastore has been created and the server is running. See External Database Error Messages on page 42
for solutions to common issues.

You can now administer the Universal Type Server the same as you would with an embedded database.

http://jtds.sourceforge.net/faq.html#urlFormat
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Installing MySQL on Mac OS X
Most of these instructions require administrator access. You should log in to the computer using an account
with administrator privileges.

NOTE

These instructions refer to MySQL Community Server, the free community-
supported version of MySQL. Your organization may prefer a commercial
version of MySQL; for more information, visit
http://www.mysql.com/products/.

Download and Install MySQL Server
1. Download the MySQL Community Server from http://www.mysql.com/downloads/mysql/. Choose

a DMG Archive (Disk Image) for your version of Mac OS X (10.5 or 10.6) and processor architecture
(x86, 32-bit or 64-bit).

2. Double-click the downloaded file to mount the disk image as a virtual disk. The DMG contains three
components that must all be installed.

3. To install MySQL, double-click the MySQL installer package and follow the instructions to complete
the installation.

4. When the MySQL installation is complete, double-click MySQLStartupItem.pkg to install the startup
item.

5. Double-click MySQL.prefPane to install the MySQL Preference Pane.

You can find detailed installation instructions online at
http://dev.mysql.com/doc/refman/5.5/en/macosx-installation-pkg.html.

Download and Install MySQL Workbench
MySQL Workbench is a powerful graphical front end for creating and administering MySQL databases.

1. Download MySQL Workbench from http://www.mysql.com/downloads/workbench/.
2. Double-click the DMG file that you downloaded. This mounts and opens a virtual disk named

MySQL Workbench.
3. Drag the MySQLWorkbench icon into your Applications folder.

NOTES ABOUT MYSQL WORKBENCH

n The interface works something like a modern web browser: some
functions will open a new tab inside the main window to display the
controls needed to complete the function. To close the tab, move your
mouse pointer to the tab, then click the X icon that appears there.

n MySQL Workbench uses the term schema synonymously with the term
database.

http://www.mysql.com/products/
http://www.mysql.com/downloads/mysql/
http://dev.mysql.com/doc/refman/5.5/en/macosx-installation-pkg.html
http://www.mysql.com/downloads/workbench/
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Create a Database
Create a Configuration File
Before you can create a server instance, you need to create a local MySQL configuration file. The easiest way
to do this is to copy a sample file that comes with MySQL.

1. Open the Terminal application.
2. Type cd /usr/local/mysql/support-files/ then press RETURN.
3. Type sudo cp my-huge.cnf /etc/my.cnf then press RETURN.
4. If you are prompted for a password, type your login password and press RETURN.
5. Type exit and press RETURN, then quit Terminal.

Create a Server Instance
1. Make sure MySQL is running. Open System Preferences, click the MySQL icon, and click

Start MySQL Server.
2. Start MySQL Workbench.
3. Under Server Administration, clickNew Server Instance.

This starts a step-by-step wizard that helps you create the server instance.
4. In the Specify Host Machine panel, choose localhost and click Continue.
5. In the remainder of the setup panels, keep the default settings and click Continue until you reach the

final panel.
6. In the Complete Setup panel, click Finish.

This will add an icon to the Connections list under SQL Development on the left, and add an
icon to the Servers list under Server Administration on the right.

7. Double-click the new icon under Server Administration. This opens an Admin tab, where you
will configure user accounts on the server.

8. ClickUsers and Privileges on the left under Security.
There may already be several accounts listed here; you can ignore them but do not delete them.

9. UnderUser Accounts, click Add Account.
10. In the Account Details Login panel, enter this information:

Login name: typesql
Password: sqltype
Confirm password: sqltype
Limit Connectivity to Hosts Matching: localhost

11. ClickAdministrative Roles.
12. In the list of roles, checkDBA, then click Apply.
13. Click Add Account and create another account with the same details and roles except use

127.0.0.1 instead of localhost for Limit Connectivity.

NOTE

The accounts for localhost and 127.0.0.1 allow access to the MySQL
Server using the typesql login from the computer that is running MySQL
Server. If you want to access this login from another computer, such as the
computer running Universal Type Server, then repeat steps 9 through 12
using the same Login name, Password, and Administrative Roles, but
use the IP address of the other computer for Limit Connectivity.

14. Close the Admin tab.
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Add a Database
1. Double-click the localhost icon under SQL Development on the left.

This will open the SQL Editor tab. The panel on the left lists the current schemas, or databases.
2. Right-click in the space below the last database in the list and choose Create Schema from the

shortcut menu.
3. In the Schema window, enter a schema name.
4. On the Default Collationmenu, choose utf-8 - default collation.
5. Click Apply.

This opens the Apply SQL Script to Database window.
6. Click Apply again.
7. Make a note of the success state of your script, then click Close in the Apply SQL Scriptwindow.
8. If your script was not successful, try again, making sure there are no illegal characters in the database

name.
Otherwise, click Close in the Schema window.

9. Close the SQL Editor tab.

Set the user permissions
1. Double-click the icon under Server Administration on the right.
2. ClickUsers and Privileges on the left under Security.
3. Click the Schema Privileges tab at the top of the Users and Privileges panel.
4. Select the typsql user in the Users list on the left.
5. Click Add Entry on the right.
6. In the Host section of the New Schema Privilege Definition dialog, click Selected host and

choose 127.0.0.1 from the pop-up menu.
7. In the Schema section, click Selected schema and select the schema you created in the section

above.
8. ClickOK.
9. Click Select "ALL" at the bottom left of the Schema Privileges panel, then click

Save Changes.
10. Click Add Entry again.
11. Click Selected host and choose localhost from the pop-up menu.
12. Click Selected schema and select the schema you created in the previous section.
13. ClickOK.
14. Click Select "ALL", then click Save Changes.

NOTE

These steps add permissions for the typesql user accessing the MySQL
Server from the computer that MySQL is installed on. If you added access for
other computers in the Create a Server Instance section above, then repeat
steps 10 through 14 to set permissions for each of those computers as well;
choose the appropriate IP address from the Selected host pop-up menu.

15. Choose File > Quit.
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Converting Between Database Types
With Universal Type Server Enterprise and an appropriate SQL database server installed, converting between
two different database types is the relatively simple process of backing up and restoring.

You may need to convert between one database type and another if you need to:
n Upgrade from the embedded database to an external SQL database.
n Troubleshoot an issue and want to maintain continuity of connection for your users.
n Perform necessary maintenance on the external SQL server.
n Port your database from one database server type to another.

In general, to convert from one database to another, backup the source database, change the database
type in Universal Type Server, then restore the backup.

Warn users
Before beginning the process, warn users that they will be logged out of Universal Type Server automatically
during the backup process.

To ensure that all current data is captured and not modified between the backup and restore processes,
users should not log back in until after the upgrade process is complete.

Backup the current database
Before you begin the conversion process, it is essential that you create a backup file of your current
installation. This backup file will be used to transfer your data between the source and target database
servers.

To backup your current Universal Type Server to your current backup location:
1. UnderDatastore on the left, click Backups.
2. Note your current backup location, and click Backup now.

Switch to the new database server
The process to switch from one database server to another varies depending upon the new database server
you are choosing, as well as the source database type.

If you are moving from the native, embedded Universal Type Server database to a new external SQL
database server, or are moving from one type of external database to another:

1. Follow the instructions to install an external database (see Installing an External Database on
page 36). This includes creating a new empty database, new database user, and connecting the to
Universal Type Server.

2. Proceed to the next step to restore your backup file.

If you are moving an external database server to an embedded Universal Type Server database:
1. Open your web browser and start the Server Administration application.
2. UnderDatastore on the left, clickDatabase.
3. Choose Database Type > PostgreSQL.
4. ClickNew Datastore.
5. Proceed to the next step to restore your backup file.
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Restore the backup
Restoring a previous backup automatically populates your new database, and performs any necessary
upgrades to the data so that it is compatible with the current version of Universal Type Server.

Follow the instructions for restoring a backup (see Restoring a Backup on page 30). This populates your
new database with your previous data.

Your database is now converted to the new database type and ready to be used.

Verify database creation and connection
After you’re done restoring the backup, check the status page of the Universal Type Server, Server
Administration application to confirm that the server has stopped and restarted. This is your indication that
the datastore has been created and the server is running. See the list of External Database Error Messages
below for solutions to common issues.

External Database Error Messages
If you are having problems during the creation or connection to an external SQL database, Universal Type
Server logs pertinent info to help you diagnose potential problems. This information is displayed in the
Status page of the Server Administration application, as well as included in the extensis.admin.log
file.

To view server status:
1. Open your web browser and start the Server Administration application.
2. Click Status in the menu on the left to display the server status page. The status window displays the

extensis.admin.log file indicating the most recent server activity.
3. Check for any error messages.

Some of the possible errors are listed in the chart below. Be sure to note any specific error messages. These
are essential for proper issue diagnosis by Extensis Technical Support.

Error message Potential issue

Error creating new datastore: Unable to connect to
database server: Network error IOException: Connection
refused: connect

Unable to connect to the specified SQL Server

Error creating new datastore: Unable to connect to
database server: Login failed for user ‘username’

SQL database login authentication failure. This may
happen in the case of wrong password, incorrect
username, nonexistent username, or improper user
permissions.

Error creating new datastore: Unable to connect to
database server: Cannot open database “databasename”
requested by the login. The login failed.

The SQL database does not exist, or was not properly
created.

Configuring Automatic Failover Services
Enterprise users can configure a system to maximize server uptime. By setting up a simple failover system,
you gain:
n Maximum server uptime
n Data consistency
n Seamless client switching when needed
n A failover license is included with the Enterprise installation
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If the primary Type Server fails, client requests are automatically and seamlessly routed to the secondary Type
Server. End users will not be aware of any change in the system.

Recommended Configuration
A proxy failover configuration that is simple to set up and maintain includes the following systems:
n A primary Universal Type Server
n A secondary (or backup) Universal Type Server
n A proxy server
n A database server
n A file server for housing the Universal Type Server font vault

Note that each of these servers should have its own backup mechanism.

The first diagram shows the components and the relationship between them.

The second diagram shows how the backup Type Server takes over if the primary Type Server fails.
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Setup
NOTE: All servers in this configuration need to be on the same subnet.

In the following instructions, when we refer to the applications folder, it is the folder named
“applications” located inside the Universal Type Server folder. By default, this folder would be:

Windows: C:\Program Files\Extensis\Universal Type Server\applications\
Macintosh: /Applications/Extensis/Universal Type Server/applications/

The instructions for configuring your servers are different depending on whether you are setting up your
system for the first time, upgrading an existing system that uses a native database, or upgrading a system
that uses an external SQL database.

Downloads
You will need to download these files to configure your servers.

Windows
n Apache Tomcat™ version 6.0.35 (do not download a newer version)

for 64-bit Windows: http://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-
tomcat-6.0.35-windows-x64.zip
for 32-bit Windows: http://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-
tomcat-6.0.35-windows-x86.zip

n Java JDK 1.5 or newer (1.7 recommended)
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html

1. Scroll down the page to the section labeled Java SE Development Kit 7u80.
2. ClickAccept License Agreement.
3. Click the download link forWindows x64 (for 64-bit Windows) orWindows x86 (for 32-bit

Windows).
n Notepad++ (recommended but not required; this is a free text editor with syntax highlighting)

http://notepad-plus-plus.org/

Macintosh
n Apache Tomcat version 6.0.35 (do not download a newer version)

http://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35.zip
n Java JDK 1.5 or newer (1.7 recommended)

http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html
1. Scroll down the page to the section labeled Java SE Development Kit 7u80.
2. ClickAccept License Agreement.
3. Click the download link forMac OS X x64.

n BBEdit (highly recommended; this is a high-powered text editor with syntax highlighting and
command-line integration that includes a very capable “free” mode)
http://www.barebones.com/products/bbedit/
Install BBEdit, launch it, and choose Install command line tools from the BBEditmenu.
The instructions that follow assume you will be using BBEdit; adjust them accordingly if you are using a
different editor (such as vi).

http://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35-windows-x64.zip
http://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35-windows-x64.zip
http://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35-windows-x86.zip
http://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35-windows-x86.zip
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html
http://notepad-plus-plus.org/
http://archive.apache.org/dist/tomcat/tomcat-6/v6.0.35/bin/apache-tomcat-6.0.35.zip
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html
http://www.barebones.com/products/bbedit/
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Other important tidbits
Other information you will need to know for configuring your servers:
n You will need the IP address for both the Primary Type Server and the Secondary Type Server.
n If you are configuring your system for single-sign on using Kerberos, the Primary and Secondary Type

Servers need to be configured with their own service accounts on the domain server, their own Service
Principal Names (SPNs), and their own keytabs.

Setting up for the first time
Primary Type Server

IMPORTANT

If you use Universal Type Server’s built-in backup scheduler to back up your
datastore, you only need to schedule backups on the Primary Type Server.
The Type Server will be in Standby mode while the scheduled backup is
running, and will return to normal access when the backup completes.

1. Install the Primary Universal Type Server. See Installation Overview on page 10.
2. Set up the Primary Type Server with the external database and external font vault. See External SQL

Database on page 35 and Moving the Vault on page 27.
3. Stop the Primary Type Server. See Stopping, Starting, and Restarting the Server on page 22.
4. Run the failover setup script on the Primary Type Server.

Windows:
a. Open a command prompt window.

Windows Server 2012: PressWIN+X and choose Command Prompt.
Windows Server 2008: Click Start, choose Run, type cmd and press ENTER).

b. Change to the applications directory inside the Universal Type Server directory.
Type cd "C:\Program Files\Extensis\Universal Type
Server\applications" and press ENTER.

c. To run the script, type win-failover-setup primary and press ENTER.
Macintosh:

a. Open the Terminal application (inside the Utilities folder in the Applications folder on your
server’s hard disk).

b. Change to the applications directory inside the Universal Type Server directory.
Type cd "/Applications/Extensis/Universal Type Server/applications" and
press RETURN.

c. To run the script, type sudo ./mac-failover-setup.sh primary and press RETURN,
then type your administrator password.

5. Start the Primary Type Server.

Configuring the Proxy Server
The following installations and other procedures are performed on the system that will become the Proxy
Server.

1. Install the Java JDK.
To confirm that the installation is functioning, open Command Prompt (Windows) or Terminal (OS X)
and type java -version. This should display the version number of the JDK that you just installed.

2. Create a system variable named JAVA_HOME set to the installation path of the Java JDK, then add this
variable to the system PATH variable.
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Windows:
a. Open the Control Panel, click System, then click Advanced System Settings on the left.
b. In the System Properties window, click Environment Variables.
c. Create a new System Variable and give it the name JAVA_HOME, set its value to the path to the

JDK installation folder (for example, C:\Program Files\Java\jdk1.7.0_80\), then click
OK.
Make sure to enter the path to the JDK files, not the JRE. Also make sure to add the trailing
backslash (\) character.

d. Edit the System Variable PATH, and add the following to the end of the existing value:
;%JAVA_HOME%bin;
IMPORTANT: Be sure to add to the end of the variable value; do not replace it!

e. ClickOK in the Environment Variables window, clickOK in System Properties, then close the
Control Panel.

f. Confirm that the environment is set correctly. Open a command prompt window, type path,
and press ENTER. The last element of the PATH variable should be the full path to the JDK bin
folder (for example, C:\Program Files\Java\jdk1.7.0_80\bin).

Macintosh:
These instructions assume you are using BBEdit’s command-line tools for editing. Adjust them
accordingly if you are using a different editor.

a. Open Terminal.
b. Type bbedit .profile and press RETURN.

The .profile file in your user directory is a shell script that is run when you log in to your Mac;
we will use this to set environment variables.

c. Scroll to the end of the .profile file. (This file may very well be empty.)
d. Type export JAVA_HOME=/Library/Java/JavaVirtualMachines/jdk1.7.0_80.jdk

and press RETURN.
Be sure to use the correct path for your version of the Java JDK.

e. Type export PATH=$JAVA_HOME/bin:${PATH} and press RETURN.
Remember that variable and path names are case sensitive!

f. Save the file and exit BBEdit.
g. Confirm that the environment variables are set correctly. Log out from your Mac, then log back

in. Open Terminal and type env.
You should see that the PATH variable now starts with the full path to the JDK bin folder, and
the JAVA_HOME variable is set as expected.

3. Install Apache Tomcat.
Make a note of where you install Tomcat; you'll need to know its location in later steps.

4. Copy the file esp-proxy.war, located in the applications folder, into the Tomcat webapps
folder.

5. In the Tomcat webapps folder, rename the ROOT folder to ROOT_original, then rename the file
esp-proxy.war to ROOT.war.
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6. Start the Proxy.
Windows:

a. Open a command prompt window.
b. Change to the bin directory of your Tomcat installation. Type (for example) cd "C:\Program

Files\apache-tomcat-6.0.35\bin" and press ENTER.
c. Type startup and press ENTER.

Macintosh:
a. Open Terminal.
b. Change to the bin directory in your Tomcat installation. Type (for example) cd

"/Applications/apache-tomcat-6.0.35/bin" and press RETURN.
c. Type sudo ./startup and press RETURN, then type your administrator password.

7. Edit data.xml to include the IP addresses of your Primary and Secondary Type Servers.
From the Tomcat installation directory, data.xml is in /webapps/ROOT/WEB-INF/config/.

a. Open data.xml in a text editor.
b. Find the lines that start with <server domainName=. Substitute the IP address for your

Primary Type Server for the text UTSserver1, and the IP address for your Secondary Type
Server for the text UTSserver2. The lines should look something like this:
<server domainName="192.168.0.101:8080" />
<server domainName="192.168.0.102:8080" />
If you have changed the port used for the HTTP/Web Service from the default value of 8080,
then use that value in the lines above.

c. Find the line that starts with <esp-proxy. If you have changed the port used for the
HTTP/Web Service from the default value of 8080, then enter that value for the
servicePort parameter. If you have changed the port used for the HTTPS/Web Service from
the default value of 8443, then enter that value for the securePort parameter.

d. Save your changes and close data.xml.
8. You will need to manually replace the server start/stop script included with the Tomcat distribution.

Windows:
a. Make a backup copy of the file catalina.bat, located in Tomcat’s bin directory.
b. Locate the file catalina.bat at /webapps/ROOT/WEB-INF/config/ in the Tomcat

installation directory.
c. Copy this file to Tomcat’s bin directory, replacing the existing file.

Macintosh:
a. Make a backup copy of the file catalina.sh, located in Tomcat’s bin directory.
b. Locate the file catalina.sh at /webapps/ROOT/WEB-INF/config/ in the Tomcat

installation directory.
c. Copy this file to Tomcat’s bin directory, replacing the existing file.
d. Make the catalina.sh script executable. In a Terminal window, enter chmod 755 followed

by the path to the file. Example:
chmod 755 /Applications/apache-tomcat-6.0.35/bin/catalina.sh
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9. Because the default Tomcat installation does not include an open port for secure traffic, you will need
to replace the existing server.xml file with one included with Universal Type Server.

a. Make a backup copy of the Tomcat default server.xml file located in Tomcat’s conf
directory.

b. Locate the server.xml file at /webapps/ROOT/WEB-INF/config/ in the Tomcat
installation directory.

c. Copy this file to Tomcat’s conf directory, replacing the existing file.
d. If you have changed the HTTP/Web Service port from the default value of 8080, then you will

need to edit the server.xml file and change all occurrences of the text port="8080" to
include the updated port value.
If you have changed the HTTPS/Web Service port from the default value of 8443, then you
will need to change all occurrences of the text port="8443" and redirectPort="8443" to
use the updated port value.

10. Shut down the Proxy.
Windows: Open a command prompt, switch to Tomcat’s bin directory, type shutdown, and press
ENTER.
Macintosh: Open Terminal, switch to Tomcat’s bin directory, type sudo ./shutdown and press
RETURN, then type your administrator password.

11. Start the Proxy again.

Configuring Tomcat as a Windows service
If your Proxy is running on a Windows server, you can configure Tomcat as a service so that it starts
automatically.

1. Open a command prompt with Administrator privileges.
2. Change to Tomcat’s bin directory.

Example: cd "C:\Program Files\apache-tomcat-6.0.35\bin".
3. Type setup.bat install and press ENTER.

This installs Tomcat as a service; you will need to configure the service to start when you want it to. Run
services.msc, right-click on the Tomcat service, select Properties, set the Startup Type, clickOK,
then close the Services window. You may also need to restart your server.
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Secondary Type Server
1. Install the Secondary Type Server.
2. Stop the Secondary Type Server.
3. Run the failover setup script on the Secondary Type Server. Follow the instructions above, but change

the script parameter primary to backup in the final step (type sudo ./mac-failover-
setup.sh backup or win-failover-setup backup).

NOTE

If you have multiple Universal Type Servers that you are configuring with
failover service, you will need to specify a unique multicast address for each
pair of Primary and Backup Type Servers. For further instructions, run the
failover setup scripts with no parameters (i.e., sudo ./mac-failover-
setup.sh or win-failover-setup.

4. Start the Server Admin application on the Secondary Type Server.
5. Enter the same serial numbers that you used for the Primary Type Server.
6. Connect to the existing external database.

The button should be labeled Join Datastore instead of New Datastore.
7. Start the Secondary Type Server.
8. Connect to the existing external vault.

Confirm configuration
NOTE: This step helps you confirm that your servers are running correctly and is completely optional.

View the most recent log file to confirm that both Primary and Secondary Type Servers are running.

Log files are in the logs folder inside the Tomcat installation directory. The most recent Tomcat log file is
named catalina.out.

Look near the end of the file for entries that resemble the following:
INFO: PRIMARY Universal Type Server : 192.168.0.101:8080 is up.

. . .

INFO: BACKUP Universal Type Server : 192.168.0.102:8080 is up.

Upgrading an existing native database
Your existing Universal Type Server will become your Primary Type Server.

1. Move your vault to an external location where it can be shared by your Primary and Secondary Type
Servers. See Moving the Vault on page 27 for instructions.

2. Back up your existing datastore. See Backing Up the Datastore on page 29.
3. Configure your external database. See External SQL Database on page 35.
4. Restore your datastore backup. See Restoring a Backup on page 30.

This copies your previous native database to the new SQL database.
5. Continue from step 3 under Setting up for the first time on page 45.
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Upgrading an existing SQL database
Your existing Universal Type Server will become your Primary Type Server. These instructions assume your
SQL database resides on a separate server from your Universal Type Server.

1. Move your vault to an external location where it can be shared by your Primary and Secondary Type
Servers. See Moving the Vault on page 27 for instructions.

2. Back up your existing datastore. See Backing Up the Datastore on page 29.
This is a precautionary measure.

3. Continue from step 3 under Setting up for the first time on page 45.
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Modules
Universal Type Server now supports add-in modules that provide functionality for specific tasks, such as
providing fonts in an automated workflow using Adobe® InDesign® Server.

To add a module’s functionality, you need to install the module on the same system with your Universal
Type Server, then enter a license for the module in the Server Admin application.

Specific modules may have other requirements; see the individual topics for each module.

To purchase a module, contact your Extensis sales representative.

FontLink

Automates font preflighting
FontLink is a module for Universal Type Server that dynamically delivers fonts for documents in automated
publishing workflows using Adobe® InDesign Server®.

Having the correct fonts during the production process is critical for any InDesign Server workflow. Missing or
incorrect fonts can quickly derail any automated processes and pull people away from other critical tasks.

FontLink solves the font management problem by easily plugging-in to any automated, multi-channel
publishing workflow, no matter how complex.

Speeds up document processing
FontLink examines and gathers fonts for InDesign documents at any point before they are handed off to
InDesign Server, removing manual document processing tasks for output.
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Ensures the correct fonts with Font Sense
FontLink leverages the same powerful Font Sense technology as Universal Type Server.

During the creative process, Universal Type Server’s font auto-activation plug-ins automatically embed Font
Sense metadata to identify and record all of fonts in use in InDesign documents.

FontLink reads Font Sense metadata from the InDesign document and collects the required fonts from
Universal Type Server for output.

Easy Content Management System integration
FontLink is easily integrated with most popular professional content management software solutions and
fits any point prior to InDesign Server processing.

Jobs are processed using straightforward input, output and error folders, ensuring the most straightforward
integration.

Delivers real-time alerts
Publishing administrators stay informed with instantaneous email alerts of font-related errors. Daily reports
of completed and failed jobs ensure efficient server monitoring and record keeping.

Contact us for pricing details and to discuss your automated publishing workflow.

FontLink and font compliance
FontLink provides copies of your document fonts to InDesign Server on demand for processing. To remain
compliant, it is important that you license your fonts for server or production use as required by their
foundries. Most Foundries offer different licensing options for the various output options (i.e. PDF output,
ePub, etc.). Please consult foundry (EULA) End User License Agreements for more information about storing
your fonts on a Server and other required licensing details.

FontLink System Requirements
FontLink Module
FontLink Module is installed on the system running Universal Type Server.
n Universal Type Server Enterprise Edition version 5.1.0 or later
n OS® X or OS X Server, v10.8 through 10.12

— OR —
Windows® Server 2008 R2, Windows Server 2012, or Windows Server 2012 R2

n 1.3 GB hard drive space

FontLink Connector
FontLink Connector is installed on the system running InDesign Server.
n Adobe InDesign Server CS6 or later
n OS® X or OS X Server, v10.8 through 10.12

— OR —
Windows® Server 2008 R2, Windows Server 2012, or Windows Server 2012 R2

n FontLink Connector requires 1.3 GB hard drive space per instance of Adobe InDesign Server

Supported documents
FontLink processes InDesign documents (INDD) and templates (INDT) from InDesign CS6 and later. In order
to work with FontLink, documents must be saved using the Extensis auto-activation plugin from Universal
Type Client version 4.0.2 or later (or Suitcase Fusion 6 v17.0.0 or later). Ensure that the Enable Font
Sense Support option is turned on for each user in the InDesign auto-activation preferences.
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You can easily upgrade documents that don’t meet these requirements by opening them in a supported
version of InDesign with the auto-activation plug-in, then re-saving them.

For font compliance purposes, InDesign files processed by FontLink must include fonts hosted on your
Universal Type Server. Files containing fonts not recognized by Universal Type Server will raise an error during
processing.

Setting up FontLink
A FontLink installation consists of several components:
n Universal Type Server
n FontLink Module
n Adobe InDesign Server
n FontLink Connector

If your organization has an email server, FontLink can send a daily digest of completed jobs, or alert
administrators to files that can’t be processed.

Order of installation
Before you can install and configure the FontLink-specific components of Universal Type Server, you need to
have a working installation of Adobe InDesign Server CS6 or later, and a working installation of Universal
Type Server Enterprise Edition version 5.1 or later.

Once you have your servers running, do the following:
1. Install FontLink Connector on your InDesign Server system.
2. Create the following folders on your InDesign Server system: a folder for jobs to be processed by

FontLink (called the Input fo lder), a folder for jobs that have been processed successfully (called the
Output fo lder), and a folder where jobs that can’t be processed are sent (called the Errors fo lder).
NOTE: These folders can be created on network volumes. Due to platform-specific differences results
may vary between operating systems.

3. By default, InDesign Server uses port 12345 to identify its first running instance. You can change this
if necessary. If you are running multiple instances of InDesign Server, you must configure each with its
own unique port number. See the InDesign Server documentation for port-specific setup instructions.

4. Install the FontLink Module on the Universal Type Server system.
5. Enter the license for the FontLink Module in the Server Admin application. See Universal Type Server

Serial Numbers on page 11.
6. Enter the details for your email server in the Server Admin application. See Configuring FontLink

notifications on page 55.
7. Connect each instance of InDesign Server in the Server Admin application. See Connecting to

InDesign Server on the next page.



- 54 -

Connecting to InDesign Server
In order for the FontLink Module of Universal Type Server to communicate with a running copy of InDesign
Server and its corresponding FontLink Connector, you need to provide information to Universal Type Server.

To identify your InDesign Server to FontLink, clickModules in the menu on the left, then click
Add a Server Instance.
n Instance Name: This identifies a specific running instance of InDesign Server in logs, email digests, and

error emails. Use a friendly and descriptive name, such as 3rd floor Production.
n IP Address (with port): This is the IP address of the system that hosts the InDesign Server and FontLink

Connector. Include the specific port for the instance of InDesign Server. By default, InDesign Server runs
on port 12345; see your InDesign Server documentation to change this.
Example: 123.45.67.89:12345

n Input Folder: Enter the full path to the folder on the InDesign Server system where FontLink will watch
for jobs to process. This folder can be local on the InDesign Server or on a network volume accessible to
the InDesign Server.
Examples:
l D:\data\fontlink-input\ (Windows local folder)
l Z:\production\fontlink-in\ (Windows remote folder; drive Z: is mapped to a network share

or folder)
l /Users/Shared/FontLink input/ (Macintosh local folder)
l /Volumes/Production/FontLink in/ (Macintosh remote folder; the volume Production

must be mounted on the InDesign server system)
n Output Folder: Enter the full path to the folder where FontLink will place processed files.
n Error Folder: Enter the full path to the folder where FontLink will move jobs that can’t be processed.
n Daily Digest Notifications: Enter a comma-separated list of email addresses where you would like to

send a daily digest listing jobs successfully processed by this InDesign Server instance. The daily digest is
sent once a day for jobs processed during the previous 24 hours.This feature requires that you enter
your network’s email server details in the FontLink Module panel.

n Error Notifications: Enter a comma-separated list of email addresses where you would like to send
messages about jobs that could not be processed. These messages are sent immediately.

Enter the above information and click Save.

Adding more connections
You can connect FontLink Module to more than one instance of InDesign Server. In this way, you can
leverage the additional processing power of your InDesign Server system.

To add another connection, follow the steps above. Be sure to enter a unique Instance Name and port
value for each instance of InDesign Server.

Your initial license for FontLink allows up to three connections to InDesign Server. Contact your Extensis
Sales representative for information about additional connections.

Removing a connection
If you need to make a change to one of your InDesign Server connections, you need to remove the
connection and then re-create it. Before you do so, make sure you have copied down any required
information.
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To remove a connection:
1. ClickModules in the list on the left.
2. Select the InDesign Server instance connection that you want to remove.
3. Click Details and copy down any information that you will need to re-create the instance, then click

 Back .
4. Select the Server Instance and click Delete. In the confirmation dialog, clickOK.

Follow the steps above to re-create the Server Instance.

Configuring FontLink notifications
FontLink can send email notification when a job cannot be processed, and can also send a daily digest listing
successfully completed jobs. In order to have FontLink send notifications, you need to enter information
about your organization’s email server.

Supported email servers
Any SMTP email server can be used to send FontLink notifications. The email server needs to be on the same
network as the FontLink module, and needs to support incoming messages without authentication.

Adding your email server
To add your email server’s details so that FontLink can send job notifications:

1. ClickModules in the menu on the left.
2. Under Email Services Setup, click Setup.
3. Enter the domain-specific name of your email server (such as smtp.example.com).
4. Enter the port used to accept incoming email message requests.
5. Click Save.

Removing your email server
To remove your email server, clickModules, then click Remove under Email Service.

Restarting FontLink services
NOTE: Universal Type Server must be running before you can restart the FontLink Module service.

Windows
To restart the FontLink Module service on a Windows server running Universal Type Server

1. Open the Services browser (Control Panel > Administrative Tools > Services, or type servces.msc
in the Run dialog).

2. Select FontLink Module Service for IDS in the list of services and clickRestart Service on
the toolbar.

To restart the FontLink Connector service on a Windows server running InDesign Server
1. Open the Services browser.
2. Select FontLink Connector Service for IDS in the list of services and clickRestart Service

on the toolbar.
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Macintosh
To restart the FontLink Module service on a Macintosh server running Universal Type Server:

1. Open a Terminal window.
2. Type sudo launchctl unload

/Library/LaunchDaemons/com.extensis.ids.fontlink.module.jboss.plist and
press RETURN. Enter your computer’s administrator password when prompted.
This stops the FontLink Module service.

3. Type sudo launchctl load
/Library/LaunchDaemons/com.extensis.ids.fontlink.module.jboss.plist and
press RETURN.
This starts the FontLink Module service again.

To restart the FontLink Connector service on a Macintosh running InDesign Server:
1. Open a Terminal window.
2. Type sudo launchctl unload

/Library/LaunchDaemons/com.extensis.ids.fontlink.connector.jboss.plist and
press RETURN.
This stops the FontLink Connector service.

3. Type sudo launchctl load
/Library/LaunchDaemons/com.extensis.ids.fontlink.connector.jboss.plist and
press RETURN.
This starts the FontLink Connector service again.

FontLink technical details
Ports
FontLink Module requires port 8485 and FontLink Connector requires port 8486 to be open so the two
servers can communicate with each other. When Module and Connector are installed on the same server
both ports must be open.

These port numbers cannot be changed, so if you have other software using either of these ports you should
change the ports used by the conflicting software.

Log files
Each FontLink component records information about its startup condition and all transactions in log files.

FontLink Module log files
FontLink Module maintains two log files:

boot.log: records environment information and status when the FontLink Module starts up
Server.log: identifies JBoss and MySQL system errors and lists all jobs processed

FontLink Module log files are located on the Universal Type Server system:
Windows: C:\Program Files\Extensis\FontLinkModule\jboss\standalone\log\
Macintosh: /Applications/Extensis/FontLinkModule/jboss/standalone/log/
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FontLink Connector log files
FontLink Connector maintains four log files:

boot.log: records environment information and status when the FontLink Connector starts up
Server.log: identifies FontLink Connector system errors related to JBoss or MySQL
fontActivationFailure.log: lists jobs that FontLink could not process
fontActivationSuccess.log: lists jobs that FontLink processed successfully

FontLink Connector log files are located on the InDesign Server system:
Windows: C:\Program Files\Extensis\FontLinkConnector\jboss\standalone\log\
Macintosh: /Applications/Extensis/FontLinkConnector/jboss/standalone/log/

Uninstalling FontLink Connector
Note: If you uninstall FontLink Connector, any workflows that rely on its Input Folder location may need to
be modified.

To uninstall FontLink Connector on Windows:
1. Choose Start > Control Panel.
2. Click Programs and Features.
3. Select Extensis FontLink Connector.
4. ClickUninstall.

To uninstall FontLink Connector on OS X:
1. Open the folderApplications > Extensis > FontLinkConnector.
2. Double-click the FontLink Connector Uninstaller.
3. Follow the instructions on screen to uninstall the FontLink Connector.

Uninstalling FontLink Module
To uninstall FontLink Module on Windows:

1. Choose Start > Control Panel.
2. Click Programs and Features.
3. Select Extensis FontLink Module.
4. ClickUninstall.

To uninstall FontLink Module on OS X:
1. Open the folderApplications > Extensis > FontLinkModule.
2. Double-click the FontLink Connector Uninstaller.
3. Follow the instructions on screen to uninstall the FontLink Module.
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Font Connector for Esko ArtPro+
Fonts play an integral role in print and packaging design. Ensuring accuracy and consistency is critical for
producing a high-quality product.

Font Connector for Esko ArtPro+ allows your users to:

n Immediately access the fonts they need
n Make on-the-fly, live text edits in PDFs
n Fix critical, last-minute text changes during the prepress stage
n Increase workflow efficiency
n Save time and money by reducing font inconsistencies and errors

Font Connector for Esko ArtPro+ is an add-on module for Universal Type Server.

Contact Extensis sales to purchase a license (https://www.extensis.com/contact-us-form).

ArtPro+ and PDFs
ArtPro+ allows you to edit normalized PDFs with embedded fonts.

Typically a PDF will only contain a subset of the font in use, so attempting to edit text with an embedded
font results in the font being replaced by a system font.

With FontConnector for ArtPro+ and Universal Type Client, you can edit the PDF and ensure that the
original font is retained, with all the appropriate characters embedded. NOTE: The original font must be
installed on your Universal Type Server.

System Requirements
n Esko ArtPro+ version 18.0 or later (see

https://wiki.esko.com/pages/viewpage.action?pageId=211029673)
n Universal Type Server version 6.1.7 or later (Professional or Enterprise)
n Universal Type Client version 6.1.7 or later (installed on the same system with ArtPro+)

Configuring Font Connector for ArtPro+
n Font Connector for ArtPro+ allows Universal Type Client to automatically activate fonts used in ArtPro+

documents.
n Enter the license for the Font Connector for ArtPro+ Module in the Server Admin application. See

Universal Type Server Serial Numbers on page 11.
n Install Universal Type Client on the same system with ArtPro+, and connect to your Universal Type

Server.
n In ArtPro+, open Preferences and click Extensis.

l Choose Enable Font Connector to allow ArtPro+ to communicate with Universal Type Client.
l Choose Activate entire font family to have Universal Type Client activate all members of the

font family (i.e. Regular, Bold, Italic, and Bold Italic). With this option off, Type Client will only
activate the precise face used in your document (for example, Helvetica Bold).

l Choose Deactivate fonts on application close to have Universal Type Client deactivate any
fonts activated by ArtPro+ for your document when you quit ArtPro+.

https://www.extensis.com/contact-us-form
https://www.extensis.com/contact-us-form
https://wiki.esko.com/pages/viewpage.action?pageId=211029673
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Command Line Administration Tool
Universal Type Server contains a command line tool that exposes a number of the functions of the Server
Administration application in command line format.

In some cases, this tool allows for more granular control of certain operations and allows these operations
to be scripted.

The tool script name is esp-admin and is available in both batch (.bat) and shell script (.sh) formats for
use on Windows and Macintosh operating systems, respectively.

The tool resides inside of the Universal Type Server’s applications subfolder. For example:
Windows: C:\Program Files\Extensis\Universal Type Server\applications\
Mac OS X: Applications/Extensis/Universal Type Server/applications/

NOTE

When running the esp-admin.bat using the Windows command prompt,
any non-ASCII characters are displayed as question marks. This can cause
issues when displaying items that allow Unicode characters, such as the
Bonjour server name.

Viewing Server Settings with the Command Line Tool
If you are unable to use the web application to initially open the Server Administration application, you can
use the command line tool to view pertinent server settings. This can happen if you are installing onto a
headless server, and there is a port conflict with the default Server Administration port.

To view server settings with the command line tool on Windows:
1. Open a Command Prompt window.

Click Start > Run, type cmd, and press Enter.
2. At the command prompt enter:

cd C:\Program Files\Extensis\Universal Type Server\applications\
3. Enter the following command to list server settings:

esp-admin -username administrator -password password -getserversettings

NOTE

If you have changed the default administrator password, enter it after
-password in the command.

To view the server settings with the command line tool on Mac OS X:
1. Start the Terminal application located in the Utilities folder inside the Applications folder.
2. At the prompt, enter:

cd "/Applications/Extensis/Universal Type Server/applications/"
3. Enter the following command to list server settings:

sudo ./esp-admin.sh -username administrator -password password
-getserversettings

The server lists a number of important server settings, including repository location, backup location, and the
ports currently in use. The port listed after esp.port.admin-web-app= is the port currently in use for the
Server Administration application.
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Properties Files
Many commands require the inclusion of data in a “properties” file to function properly. These files are
basically lists of options and the selected values for those options.

Properties files must be saved as standard ASCII text files, and cannot include any high ASCII characters.

The following is an example of the contents of a properties file.
esp.backup.location=C://backups/
esp.backup.filename=mybackup.tar
esp.option.backup.stayinquiescentmode=false

NOTE: Paths in the properties file must be specified differently than they are in Windows. Use the form <drive_
letter>://<folder>/<folder>/<file>; for example, C://backups/ or
C://Program Files/Extensis/Universal Type Server/data/vault.

Properties files are used with the following commands:
backupdatastore (see backupdatastore on the next page.)
createdatastore (see createdatastore on page 63.)
moverepository (see moverepository on page 67.)
restoredatastore (see restoredatastore on page 67.)

Specifying a Username and Password
Almost every command line operation requires the addition of a username and password that has
administrative privileges.

The username and password can be specified in the command line each time a command is executed, or it
can be specified as an environment variable.

The two environment variables that can be set are:
n ESP_ADMIN_USER, which by default is set to the value administrator, the Server Administrator

username; and
n ESP_ADMIN_PW, which by default is set to the value password, the default Server Administrator

password.

The following is an example of specifying the username and password in the Windows command line when
adding a serial number:

esp-admin ESP_ADMIN_USER ESP_ADMIN_PW -addserialnumber XXXX-1234-ABCD-EFGH-
IJKL-MNOP

For assistance setting environment variables, see the documentation for your operating system.
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Commands
backupdatastore
-backupdatastore [-properties properties.txt] [-force]

Backs up the datastore.

-properties: use properties specified in the file properties.txt.

-force: automatically accept all interactive confirmation prompts.

The properties file is a plain text file that can contain any or all of the following optional settings:

esp.backup.location=full_backup_path

The complete path to the backup directory. If not specified, the default backup directory is used.

NOTE: Paths in the properties file must be specified differently than they are in Windows. Use the form
<drive_letter>://<folder>/<folder>/<file>; for example, C://backups/ or
C://Program Files/Extensis/Universal Type Server/data/vault.

esp.backup.filename=filename.zip

Name of the backup file. The backup is stored as a .ZIP compressed archive; you must include the .ZIP
extension in the filename. If you don’t specify a filename, the backup will be named using the pattern
year_mo_dy_hr_mn.zip.

esp.option.backup.stayinquiescentmode=boo lean

Specifies whether the server will be left in “quiescent” or standby mode after the backup is complete. Valid
values are true or false; the default is false.

Use this command to backup the datastore. This command can be used alone, or with a properties file that
contains multiple parameters. In addition, the option to dismiss all interactive confirmation prompts is
controlled with the force option.

-backupdatastore -properties properties.txt -force
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The following properties can be specified in the properties file.

Property Description Required

esp.backup.location The full, complete directory path to where the backup
file will be placed. If not specified, the default backup
directory is used.

No

esp.backup.filename Name of the backup file. If not specified, the server will
use the default backup file naming convention of
yyyy_mm_dd_hh_mm.zip

No

esp.option.backup.stayinquiescentmode Specifies that the server be left in quiescent (standby)
mode after backup. Valid values are true or false.
Default value is false.

No

NOTE: Paths in the properties file must be specified differently than they are in Windows. Use the form
<drive_letter>://<folder>/<folder>/<file>; for example, C://backups/ or
C://Program Files/Extensis/Universal Type Server/data/vault.

Windows usage example:
esp-admin -username ssmith -password stevespass -backupdatastore -properties

properties.txt -force

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -backupdatastore

-properties properties.txt -force

canceldatastoreoperation
This command cancels any current datastore operation, and does not have any parameters.

-canceldatastoreoperation

Windows usage example:
esp-admin -username ssmith -password stevespass -canceldatastoreoperation

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass

-canceldatastoreoperation

checkdatastoreoperationstatus
This command checks the status of any current datastore operations, and does not have any parameters.

-checkdatastoreoperationstatus

Windows usage example:
esp-admin -username ssmith -password stevespass -checkdatastoreoperationstatus

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass

-checkdatastoreoperationstatus
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createdatastore
-createdatastore -properties properties.txt [-force]

Creates a new database with the properties specified in properties.txt.

esp.repository.directory=fo lder_name

Required. This is the name of the folder that contains the datastore.

esp.repository.type=esp.repository.type.vault

Required. Currently, esp.repository.type.vault is the only supported repository type.

esp.database.driver=esp.database.driver.PostgreSQL

Required. Currently, esp.database.driver.PostgreSQL is the only supported database driver.

esp.database.username=user

Optional. The database user’s name.

esp.database.password=password

Optional. user’s password to access the database.

esp.database.hostport=host:port

Optional. Host and port used to connect to the database, in the form host:port. host can be any
valid host identifier: the word localhost, an IP address, or a server name; port is the JBoss Web App
port.

esp.database.datapath=full_path_to_database

Optional. If not specified, the default location is used.

esp.option.backup.stayinquiescentmode=boo lean

Optional.

This command creates a new datastore using a properties file. Before using this command, be sure to have a
backup of your current datastore.

This command relies upon the creation of a properties file (see Properties Files on page 60). In addition,
the option to dismiss all interactive confirmation prompts is controlled with the force option.

-createdatastore -properties properties.txt -force
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The following properties can be specified in the properties file.

Property Description Required

esp.repository.directory The top level of the datastore. Yes

esp.repository.type The only supported value is
esp.repository.type.vault.

Yes

esp.database.driver Logical name of database type to use. Currently the
only supported value is
esp.database.driver.PostgreSQL.

Yes

esp.database.username The database user name. No

esp.database.password The database password. No

esp.database.hostport Host and port used to connect to the database.
Formatted host:port, for example:
localhost:3487.

No

esp.database.datapath Path to the database. No

esp.option.backup.stayinquiescentmode Specifies that the server be left in quiescent (standby)
mode after creating the datastore. Valid values are
true or false. Default value is false.

No

NOTE: Paths in the properties file must be specified differently than they are in Windows. Use the form
<drive_letter>://<folder>/<folder>/<file>; for example, C://backups/ or
C://Program Files/Extensis/Universal Type Server/data/vault.

Windows usage example:
esp-admin -username ssmith -password stevespass -createdatastore -properties

properties.txt -force

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -createdatastore

-properties properties.txt -force

directorysynchronize
With directory integration, Universal Type Server is bound to a Directory Service. This command
synchronizes Universal Type Server with the Directory Service.

-directorysynchronize

Windows usage example:
esp-admin -username ssmith -password stevespass -directorysynchronize

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass

-directorysynchronize

forcelogouts
This command forces the logout of a specific user as identified by session ID (or GUID).

To identify a user’s session ID, use the getlogins command (see getlogins on the next page). This
command returns a list containing the username, long username, IP address of login client, the login time,
as well as the necessary session ID which is also known as the user GUID.

-forcelogouts sessionID
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Windows usage example:
esp-admin -username ssmith -password stevespass -forcelogouts 28203500-FA5D-

8A0A-27BC-E7996E17EDC1

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -forcelogouts

28203500-FA5D-8A0A-27BC-E7996E17EDC1

forcelogoutswithfile
This command forces the logout of a list of users contained within a userlogout text file. The text file must
contain one user session ID (or GUID) per line.

To identify a user’s session ID, use the getlogins command. This command returns a list containing the
username, long username, IP address of login client, the login time, as well as the necessary session ID
which is also known as the user GUID.

-forcelogoutswithfile -file userlogout.txt

Windows usage example:
esp-admin -username ssmith -password stevespass -forcelogoutswithfile -file

userlogout.txt

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass

-forcelogoutswithfile -file userlogout.txt

getlogins
This command lists all users currently logged in to the Type Server and does not have any parameters.

This command returns a list containing the username, long username, IP address of login client, the login
time, and the session ID which is also known as the user GUID. The user session ID can be used to force the
logout of specific users using the forecelogouts or forcelogoutswithfile commands (see
forcelogouts on the previous page and forcelogoutswithfile above).

-getlogins

Windows usage example:
esp-admin -username ssmith -password stevespass -getlogins

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -getlogins
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getserversettings
This command displays a list of the current server settings.

-getserversettings

The following is a list of server properties displayed by this command:

Property Description

esp.container.autostart This is the autostart setting of the server: enabled or disabled.

esp.core.bonjour.name The current Bonjour name of the server.

esp.core.repository.location The location of the server vault.

esp.core.service.backup.directory Directory where backup files are to be written. This path should allow
changes.

esp.core.service.backup.schedule Backup schedule expression. Expression must adhere to the formats
supported by Quartz.

esp.core.service.logging.level The logging level of the server: error, warn, info, or debug.

esp.core.service.logging.location Directory where logs are to be written. This path should allow changes.

esp.core.service.state The current state of the server: started, stopped, or standby.

esp.port.admin-web-app The Server Administration port, also called the Jetty Web App port.

esp.port.bootstrap-jnp The Bootstrap JNP Server Bind Address port.

esp.port.http The User Management port. This port is also used for client connection
and also called the JBoss HTTP / Web Service port.

esp.port.jmx-pooled The JMX Pooled Port.

esp.port.jmx-rmi The JMX RMI Object Port.

esp.port.rmi-naming The RMI Naming Service port.

esp.port.webservice The JBoss Webservice port.

Windows usage example:
esp-admin -username ssmith -password stevespass -getserversettings

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -getserversettings



- 67 -

moverepository
This command moves the font vault (also called the repository) to a new location. This command relies
upon the creation of a properties.txt file (see Properties Files on page 60).

-moverepository -properties properties.txt

The following properties can be specified in the properties file.

Property Description Required

esp.repository.directory The top level of the datastore. Yes

esp.repository.type The only supported value is
esp.repository.type.vault.

Yes

esp.option.backup.stayinquiescentmode Specifies that the server be left in quiescent (standby)
mode after moving the datastore. Valid values are true
or false. Default value is false.

No

NOTE: Paths in the properties file must be specified differently than they are in Windows. Use the form
<drive_letter>://<folder>/<folder>/<file>; for example, C://backups/ or
C://Program Files/Extensis/Universal Type Server/data/vault.

Windows usage example:
esp-admin -username ssmith -password stevespass -moverepository -properties

properties.txt

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -moverepository

-properties properties.txt

reapseats
This command synchronously removes any unused client seats that have not synchronized with the server
within 30 days.

-reapseats

Windows usage example:
esp-admin -username ssmith -password stevespass -reapseats

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -reapseats

restoredatastore

WARNING

restoredatastore is destructive; it will replace your current datastore with
the contents of the specified backup. Be sure this is what you want to do
before you execute restoredatastore.

Use this command to restore a backup copy of the datastore. This command relies upon the creation of a properties.txt
file (see Properties Files on page 60). In addition, the option to dismiss all interactive confirmation
prompts is controlled with the force option.

-restoredatastore -properties properties.txt -force
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The following properties can be specified in the properties file.

Property Description Required

esp.backup.location Directory of the backup file. If not specified, the
default server backup directory is assumed.

No

esp.backup.filename Name of the backup file. Yes

esp.repository.directory The top level of the datastore.By default this is
Applications/Extensis/Universal Type
Server/data/vault on Macintosh or C:\Program
Files\Extensis\Universal Type
Server\data\vault on Windows.

Yes

esp.repository.type The only supported value is
esp.repository.type.vault.

Yes

esp.database.driver Logical name of database type to use. Currently the
only supported value is
esp.database.driver.PostgreSQL.

Yes

esp.database.username The database user name. No

esp.database.password The database password. No

esp.database.hostport Host and port used to connect to the database.
Formatted host:port, for example:
localhost:3487.

No

esp.database.datapath Path to the database. No

esp.option.backup.stayinquiescentmode Specifies that the server be left in quiescent (standby)
mode after restoring the datastore. Valid values are
true or false. Default value is false.

No

NOTE: Paths in the properties file must be specified differently than they are in Windows. Use the form
<drive_letter>://<folder>/<folder>/<file>; for example, C://backups/ or
C://Program Files/Extensis/Universal Type Server/data/vault.

Windows usage example:
esp-admin -username ssmith -password stevespass -restoredatastore -properties

properties.txt -force

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -restoredatastore

-properties properties.txt -force
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setautostart
This command sets the whether the Type Server launches automatically when the computer starts. This
command takes a single parameter with one of two values: enabled or disabled.

-setautostart value

Windows usage example:
esp-admin -username ssmith -password stevespass -setautostart enabled

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -setautostart

enabled

setbackupdirectory
This command sets the location where backups are stored. The path must a full path and the target location
must be writable.

-setbackupdirectory fullpath

Windows usage example:
esp-admin -username ssmith -password stevespass -setbackupdirectory

c:\this\is\my\backup\

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -setbackupdirectory

"/Applications/Extensis/Universal Type Server/mybackups/"

setlogdirectory
This command sets the location where log files are stored. The path must be a complete path and the user
must have write access to the target location.

-setlogdirectory fullpath

Windows usage example:
esp-admin -username ssmith -password stevespass -setlogdirectory

c:\this\is\my\backup\

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -setlogdirectory

"/Applications/Extensis/Universal Type Server/mybackups/"

setlogginglevel
This command sets the logging level of the server and can be set to one of four case-sensitive values:
n error
n warn
n info
n debug

-setlogginglevel value

Windows usage example:
esp-admin -username ssmith -password stevespass -setlogginglevel info
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Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -setlogginglevel
info

setmaxbackuplogs
This command sets the maximum number of log files that are backed up.

-setmaxbackuplogs count

countmust be a whole number greater than zero. The default is 10.

Windows usage example:
esp-admin -username ssmith -password stevespass -setmaxbackuplogs 15

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -setmaxbackuplogs
7

setport
This command is used to set the ports to which clients connect, the User Management port
(esp.port.http) as well as the Server Administration port (esp.port.admin-web-app).

The values must be between 1 and 65536 and not conflict with any other ports currently in use.

-setport portname=value

To change the client connection and the User Management application port (JBoss HTTP / Web Service
port), use the following command:

esp-admin -username administrator -password password -setport
esp.port.http=PORT_NUM

Windows usage example:
esp-admin -username ssmith -password stevespass -setport
esp.port.http=8080

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -setport
esp.port.http=8080

To change the Server Administration application port (Jetty Web App port), use the following command:
esp-admin -username administrator -password password -setport
esp.port.admin-web-app=PORT_NUM

Windows usage example:
esp-admin -username ssmith -password stevespass -setport
esp.port.admin-web-app=18081

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -setport
esp.port.admin-web-app=18081

setservername
This command sets the name used by Bonjour to advertise to clients.

-setservername name
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Windows usage example:
esp-admin -username ssmith -password stevespass -setservername mysnazzyserver

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -setservername

mysnazzyserver
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setserversettings
Use this command to set a number of server settings using a properties.txt file (see Properties Files
on page 60). All undefined values in the properties file are ignored.

-setserversettings -properties properties.txt

The following is a list of server properties available to be set using this command:

Property Description

esp.container.autostart This is the autostart setting of the server: enabled or disabled.

esp.core.bonjour.name The Bonjour name of the server. Any alphanumeric value is acceptable.

esp.core.repository.location The complete full path to the server vault.

esp.core.service.backup.directory Directory where backup files are to be written. This path must allow
changes.

esp.core.service.backup.schedule Backup schedule expression. Expression must adhere to the formats
supported by Quartz.

esp.core.service.logging.level The logging level of the server. Four case-sensitive values are
acceptable: error, warn, info, or debug.

esp.core.service.logging.location Complete path to the folder where logs are to be written. This folder
must allow changes.

esp.core.service.state The current state of the server can be set to one of three case-sensitive
values: started, stopped, or standby.

esp.port.admin-web-app The Server Administration port, also called the Jetty Web App port. Any
positive integer between 1 and 65536 inclusive.

esp.port.bootstrap-jnp The Bootstrap JNP Server Bind Address port. Any positive integer
between 1 and 65536 inclusive.

esp.port.http The User Management port. This port is also used for client connection
and also called the JBoss HTTP / Web Service port. Any positive integer
between 1 and 65536 inclusive.

esp.port.jmx-pooled The JMX Pooled Port. Any positive integer between 1 and 65536
inclusive.

esp.port.jmx-rmi The JMX RMI Object Port. Any positive integer between 1 and 65536
inclusive.

esp.port.rmi-naming The RMI Naming Service port. Any positive integer between 1 and
65536 inclusive.

esp.port.webservice The JBoss Webservice port. Any positive integer between 1 and 65536
inclusive.

Windows usage example:
esp-admin -username ssmith -password stevespass -setserversettings -properties

properties.txt

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -setserversettings

-properties properties.txt
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setstate
Use this command to change the running state of the server. The server can be started, stopped or put into
standby mode with the following case-sensitive values:
n started
n stopped
n standby

-setstate value

Windows usage example:
esp-admin -username ssmith -password stevespass -setstate stopped

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -setstate stopped

tailadminlog
This command displays the most recent activity in the extensis.admin.log file and takes no
parameters. This log file is located in the Universal Type Server logs subdirectory.

-tailadminlog

Windows usage example:
esp-admin -username ssmith -password stevespass -tailadminlog

Macintosh usage example:
sudo ./esp-admin.sh -username ssmith -password stevespass -tailadminlog
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Contacting Extensis
Extensis
1800 SW First Avenue, Suite 500
Portland, OR 97201
Phone: (503) 274-2020 (not for support)
Fax: (503) 274-0530
Web: https://www.extensis.com

Extensis Europe
Suite 18, Newton House
Kings Park Road, Moulton Park
Northampton NN3 6LG, United Kingdom
Phone: +44 (0)1604 654 270
Fax: +44 (0)1604 654 268

Customer Service
Web: https://www.extensis.com/contact/
Support Request: https://help.extensis.com/hc/en-us/requests/new

Sales
Phone: (503) 274-4492 (North America)
Email: NA_sales@extensis.com (North America)
Web: https://www.extensis.com/contact-us-form/ (all regions)
We also work with distributors around the world; find one near you.

Celartem, Inc.
Phone: +81 3 5574 7236
Email: sales_ap@celartem.com
Web: http://www.celartem.com/en/

https://www.extensis.com/
https://www.extensis.com/contact/
https://help.extensis.com/hc/en-us/requests/new
mailto:NA_sales@extensis.com
https://www.extensis.com/contact-us-form/
https://www.extensis.com/resellers/
mailto:sales_ap@celartem.com
http://www.celartem.com/en/
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Technical Support
Technical support for current products is available through the Extensis website
(https://www.extensis.com/support/).

Extensis also maintains a searchable Knowledge Base of in-depth articles on various technical topics.

Creating a tech support case
If you are experiencing a problem with a current product, you can submit a tech support case using this
Support Request.

Provide as much of the following information as you can:

n Product name and version number;
n Serial number, if you have it available;
n Computer operating system version;
n Other details about your computer system, including RAM, hard drive size and free space, and processor

type and speed;
n A description of the problem, including any error message that might be displayed;
n Your contact information.

Support Policy
Extensis provides full support for the current version of all shipping products. In addition, Extensis provides
limited support for older products up to one year after the product version is no longer offered for sale. For
complete details see the Support Policy.

For details on currently supported products, see:

n Portfolio Support Guide (https://www.extensis.com/support/portfolio-support-guide/)
n Universal Type Server Support Guide (https://www.extensis.com/support/universal-type-

server-support-guide/)
n Universal Type Client Support Guide (https://www.extensis.com/support/universal-type-client-

support-guide/)
n Suitcase Fusion Support Guide (https://www.extensis.com/support/suitcase-fusion-support-

guide/)

https://www.extensis.com/support/
https://www.extensis.com/support/
https://help.extensis.com/hc/en-us/
https://www.extensis.com/integration-and-consulting-services/
https://www.extensis.com/support/support-policy/
https://www.extensis.com/support/portfolio-support-guide/
https://www.extensis.com/support/portfolio-support-guide/
https://www.extensis.com/support/universal-type-server-support-guide/
https://www.extensis.com/support/universal-type-server-support-guide/
https://www.extensis.com/support/universal-type-server-support-guide/
https://www.extensis.com/support/universal-type-client-support-guide/
https://www.extensis.com/support/universal-type-client-support-guide/
https://www.extensis.com/support/universal-type-client-support-guide/
https://www.extensis.com/support/suitcase-fusion-support-guide/
https://www.extensis.com/support/suitcase-fusion-support-guide/
https://www.extensis.com/support/suitcase-fusion-support-guide/
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